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Welcome!
Welcome to the Cubasis AV on-line documentation! 

Please use one of the methods described below to quickly find the desired 
information:

• Use the Table of Contents provided by the Adobe Acrobat Reader program.
• Use the Adobe Acrobat Reader Search function.
• Click on a cross-reference (green text) to jump to the respective topic.

It is possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can be 
found in its on-line Help.
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How you can reach us
You can find us at the World Wide Web, at the following address: 

• www.steinberg.net. 

Here you can find the following sections (among others):

• The Service Web contains support information, answers the frequently asked 
questions etc.

• You can send email to our support personnel from the web pages.
• On the Web site you will find the latest update of your program and demo 

version of other Steinberg products, for instant download.
• The web User Area lets Cubasis AV users world wide communicate and ex-

change information.
• The Web pages also have sections for Education and Multimedia users.
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Why you should read this Chapter
In this chapter, none of the actual features of Cubasis AV are described. Instead, the 
chapter contains information about the general methods you need to employ when 
using Cubasis AV, plus some useful terminology. These methods are the same in 
every part of the program, whether you are making a basic recording, or using 
Cubasis AV at its most advanced level. To make your work with Cubasis AV as ef-
fective as possible, please take some time to read this chapter.
- 13 - 



Cubasis AV Building Blocks
When you record audio or MIDI, your recorded sounds or 
MIDI signals are packed into “containers” called Parts.

Parts reside on Tracks. There are eight Audio 
Tracks and sixteen MIDI Tracks. The Parts and 
Tracks make up an Arrangement.

You can work on a number of Arrangements 
simultaneously. Together they form a Song.

An Arrangement with the 
total of twenty fourTracks.
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Tools
When you are working with Cubasis AV, you need different tools in different situa-
tions. You may for example want to input notes using a Pencil tool, or delete notes 
using an Eraser tool. There are a lot of other tools as well.

Some examples of tools

What are the Toolboxes?

The various tools you may need in a certain situation are gathered in a Toolbox. 
This is essentially a “box” containing an icon for each tool. Each of the main win-
dows in Cubasis AV has its own Toolbox, containing the respective necessary tools. 
All the main tools are described in the chapters “Arrangement Editing” and “The 
MIDI Editors - General Information”.

Some examples of Toolboxes
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Selecting a Tool from a Toolbox

Using the Toolbox as a menu

You may simply choose tools from the menu bar:

1. Pull down the “Tools” menu on the menu bar.

2. Position the pointer over a tool and release the mouse button.
The pointer takes on the shape of the selected tool.

3. When you have finished using a tool, simply choose another from the 
Toolbox.
- 16 - 



Using the Toolbox as a window

You can "tear off" the Toolbox from the menu bar if you want it to appear as a sep-
arate window:

1. Pull down the "Tools" menu on the menu bar.

2. With the mouse button pressed, drag the Toolbox to a new place.
An outline of the Toolbox shows you where it will be positioned.

3. Release the mouse button.
The Toolbox appears in its new position.

• This can also be done by holding down [Control] and clicking wherever 
you want the Toolbox window.
- 17 - 



4. If you want to move or close the Toolbox, proceed as with any Macintosh 
window.

• You can always select “Tools” from the menu bar, even if the Toolbox is 
already opened as a window.

Selecting a Tool from the Toolbar

In the Arrange window, you also have the option to select tools from the Toolbar 
above the Part display.

When “torn off”, the Toolbox 
has a title bar with a close box, 
just like an ordinary window.

Click on one of the tool icons 
to select a tool.
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Pop-Up Menus
Throughout the program you will select values from pop-up menus. These differ a 
bit from the regular “menu bar menus”. Pop-up menus may be located anywhere in 
a window, and are not on a menu bar. But selecting is done similarly from all menus, 
pop-up or regular.

Press the mouse button 
with the pointer positioned 
on the small triangle...

...to pull down a pop-up 
menu.
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About Positions
Cubasis AV works with a resolution of 384 fractions (or ticks) per quarter note. You 
will often work with position values in the Arrange window. Positions in Cubasis AV 
are displayed as Bars, Beats (quarter notes) and Ticks. 

The first Beat of the first Bar, in other words the beginning of the Song.

Bars
Beats

Ticks
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Setting Values
Throughout Cubasis AV you will find different values, such as meter position, 
tempo, volume, etc. There are several ways to change such values:

By typing

You can double click on a value field. The value is highlighted, and you can type in 
a new value and press [Return]. You can use the numeric key pad as well as the nor-
mal keyboard in most cases.

If you are editing a value that is “segmented”, such as a Song Position or a decimal 
number, you can use spaces, dots, commas or any character that is not a number, to 
separate the numerals. However, you don’t have to type in all the numerals. If you 
just type in a single number, you will change the largest numeral in the segmented 
value, and all the lesser numerals will be set to their lowest values. 

Double clicking on this 
value (Song Position)...

...brings up a 
highlighted value box.

If you type a single 
value and press 
|Return|...

...the lesser numerals get 
their lowest values 
automatically.
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By using the Mouse

You can use the mouse to either change a value by single steps or continuously 
scroll it up or down.

Method 1

1. Position the pointer in the upper half of the value field to increase the 
value.
If you want to decrease the value, position the pointer in the lower half of the 
value field.

2. Click once.
The value will increase/decrease by one step.

3. Continue clicking until you have reached the desired value.

• If you hold down [Shift] while clicking, the value will change in larger 
steps (often steps of ten).
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Method 2

1. Press and hold down the mouse button with the pointer over the value.
An arrow appears and the value will scroll up or down, slowly at first and 
then faster.

2. Release the button when you have reached the desired value.

• If you hold down [Shift] while using the mouse, the value will scroll in 
larger steps (often steps of ten).

Pressing the mouse 
button with the pointer 
in the upper half of a 
value field.

Pressing the mouse 
button with the pointer 
in the lower half of a 
value field.
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Changing a value by dragging

If you click on a value and drag the mouse up or down with the button pressed, the 
vertical movement of the mouse changes the value, just as if you were dragging an 
invisible fader.

About changing “segmented” values

If you are using the mouse to change a “segmented” value such as a position or a 
decimal number, you can change any one of the “segments” individually. In a posi-
tion value for example, you can change the bar, beat and tick values independently, 
just by positioning the pointer at the right numeral.

...or down.

If you click on a value and keep the mouse button pressed...

...you can "drag the value" up...

Clicking on the “Beats” value...

...will change this value o
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Naming
You can give names to Tracks, Parts and other items in Cubasis AV. To edit a name 
just double click on it. The text gets highlighted and you can type in the changes 
you want to make. You can use the arrow and [Backspace] keys, just as in any text-
editing program.

Double clicking on the name... 

...highlights it and makes it ready to edit.
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Window Techniques
Cubasis AV windows are regular Macintosh windows, which means standard  Mac 
"window handling procedures" apply. You may move, resize, scroll and close win-
dows using standard procedures. But there are also a couple of special features:

Changing the Magnification

In some of the windows a couple of magnifying glasses appear on each scroll-bar. 
Click on the magnifying glass with the plus sign to increase magnification. The 
magnifying glass with the minus sign will decrease magnification.

The magnification glasses on the left/right scroll bar change the horizontal magnifica-
tion. The glasses on the up/down scroll bar change the vertical magnification. If you 
click on a magnifying glass and keep the mouse button pressed, the magnification 
factor will change continuously, allowing you to zoom in or out.

The vertical magnifying glasses

The horizontal magnifying glasses
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You can also change the magnification from the computer keyboard, using the fol-
lowing keys:

The Divider

The Arrange window is divided into two sections. The “border” between the sections 
is called the Divider. If you position the pointer on the Divider, the pointer takes on 
the shape of a hand. If you then click on the Divider and drag it in the direction of one 
of the sections, you will shrink that section and enlarge the other.

Dragging the Divider in the Arrange Window.

[G] Decrease horizontal magnification.

[H] Increase horizontal magnification.

[Shift]-[G] Decrease vertical magnification.

[Shift]-[H] Increase vertical magnification.
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The Transport Bar

This is a special window that, among other things, contains the transport controls: 
Play, Stop, Record, Rewind and Fast Forward. These work much like the controls 
on a tape recorder. Read more about the Transport Bar in the “Playback, Tempo and 
the Transport Bar” chapter.

The Transport Bar differs from standard Macintosh windows. It doesn’t have a title 
bar (the area at the top, used for dragging a window around on the screen). Instead 
you use the “handles”, at each side of the window, to move the Transport Bar. Also, 
the Transport Bar will never be obscured by other Cubasis AV windows, but always 
stays on top.

Dialog Boxes
When you select a function from a menu, sometimes a dialog box appears. This is a 
type of window, but it can’t be moved or resized. After you have input the necessary 
information using the mouse and/or keyboard you close the dialog box by clicking 
on a button called “OK”, “Do It!” or something similar, or by pressing [Return] on 
the computer keyboard.

Even when you have a dialog box open you can still use the numeric key pad for the 
functions on the Transport Bar (Start, Stop and so on).
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Using the Computer Keyboard
When you are working with Cubasis AV, the computer keyboard has several different 
uses:

Transport Controls

The Transport functions (such as Play, Stop, Record and so on) can all be managed 
from the computer keyboard. The keyboard commands for these functions are located 
on the numeric key pad, to the right of the main computer keyboard. See page 75 in 
this book.

Keyboard Shortcuts

Many of the items on Cubasis AV menus have a computer keyboard equivalent - a 
“shortcut”. These keyboard shortcuts generally use keys on the left of the main 
computer keyboard. Those of you who have experience with the Macintosh will 
feel at home since Cubasis AV follows the standard guidelines when it comes to 
keyboard commands for functions like New, Open, Save, Close, Quit, Cut, Copy 
and Paste and so on.
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How Keyboard Commands are displayed in this Manual

The following list shows how the “special” keys on the computer keyboard are dis-
played in this manual.

When the text says something like “press [Command]-[T]” this means that you 
should hold down the Command key on the Macintosh keyboard and press T once.

In this manual: On some keyboards:

[Shift]

[Option]

[Command]

[Tab]

[Return]

[Backspace]

[Enter]
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Undo
Cubasis AV has a wide-ranging Undo function. This means that if you regret your 
last action, you can Undo it. This is very helpful when something doesn’t turn out 
as intended. Remember that it is only the last action that can be undone.

You Undo an action by selecting “Undo” from the Edit Menu, or by pressing 
[Command]-[Z] on the computer keyboard.

If you wish to “Undo the Undo”, this is possible. The menu text changes to “Redo” 
after an Undo (for example “Redo Delete”). If the menu item is grey, nothing can 
be undone.

Often the menu item Undo tells you what 
will be undone at any given moment. In 
this case, "Undo Delete" means the last 
deletion will be undone.
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Real Time
Cubasis AV is a true real-time program. It has sophisticated multi-tasking proce-
dures that let you do almost anything (like loading from, and saving to disk) without 
interrupting the music.

In some instances the notes sounding at the moment have to be cut off, but timing is 
never affected.

● In general, don’t turn off playback or recording just because you want to try a 
command or a function, just do it!
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Selecting a sound source for recording
Before starting to record audio, you must decide what type of sound source you 
want to record. There are two basic options:

• Recording a sound source connected to the audio inputs of the Macintosh.
This could be a microphone, a mixer or any electrical musical instrument.

• Recording audio from the internal CD-player.
You may for example want to record loops and sounds from a Sample CD.

To “tell” the computer which type of sound source you want to record, proceed like 
this:

1. Quit Cubasis AV.

2. In the Finder, open the “Monitors and Sound” control panel and select 
the page with Sound settings.

3. Pull down the Audio Input pop-up menu and select the option you want 
(“External Microphone” or “Internal CD”).

4. Close the control panel and re-launch Cubasis AV.
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Preparing a Track
1. Select one of the eight Audio Tracks by clicking on its name field in the 

list.
The Audio Tracks are the eight Tracks at the top of the list in the Arrange 
Window.

2. Double click on the Track name, type in a new name for the Track and 
press [Return].
Use names that correspond to the sounds or instruments you are going to 
record. This will make audio file handling easy later on!

3. Open the Inspector.
This is done by clicking on the Inspector icon below the Track list.

Click here,
to open the Inspector
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4. Decide whether you want to make a mono or a stereo recording, by 
clicking on the Mono/Stereo button.
If you select Mono, the signal from the left input channel will be recorded.

● You can only change the Mono/Stereo setting if the Track is empty. Once you 
have recorded, imported or dragged any audio onto the Track, you cannot 
change the Mono/Stereo setting.

Selecting a folder for your Audio Files

When you record, audio files are created on your hard disk. Before you start record-
ing for the first time in a new Song, you need to tell the program where to put the 
audio files:

1. In the Inspector, double click on the Record Info box.
A file dialog appears.

2. Open the folder you want to use for your audio files and click “Select”.
You can switch the audio file folder later on if you want to.
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About Monitoring
Monitoring (listening to your sound source through Cubasis AV while recording) is 
automatically activated as soon as you select an Audio Track. More specifically:

The sound of the connected sound source will be monitored via the Audio Mixer if:

• An Audio Track is selected.
• The Track is unmuted.
• Cubasis AV is in Stop or Record mode.

In Play mode, monitoring is deactivated.

● Due to the design of the Macintosh, there will always be a slight delay in the 
monitored sound. If you prefer to listen to the sound source directly or via an 
external mixer, you can lower the level of the Audio Track in the Audio Mixer 
during recording. This will not affect the volume of the recorded sound.
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Setting Recording Levels
In Cubasis AV, there is no input level setting. Instead, you have to set the recording 
level at your sound source, i.e. your mixer or your instrument. To check if the input 
level is OK, proceed as follows:

1. Make sure the correct Audio Track is selected.
You should be able to hear the sound source through Cubasis AV.

2. On the Transport Bar, click on the button marked “AudioMix”.
The Audio Mixer window opens. This window (described in detail in the 
chapter “Mixing”) contains eight “channel strips”, one for each Audio Track.
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Click here to open 
the Audio Mixer
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3. Make sure that the volume fader for the selected Audio Track is set to 
“0”, and do the same with the the master fader to the right.

4. Make sure that the Treble and Bass knobs for the selected Audio Track 
are in their middle position.
Neither the faders nor the Treble and Bass controls affect the actual recording 
- but they affect the level meters.

5. Play or sing just as if you were actually recording.
Now, the level indicator for the Audio Track (at the top of the channel strip) 
moves with the sound, giving you a rough impression of the input level.

6. Set the out level on your sound source, so that the level indicator goes 
into the orange area occasionally.
To avoid clipping (distortion), the meter should not go all the way up, or be in 
the orange area constantly. Unlike analog distortion, digital clipping results in 
clearly audible and very unpleasant distortion.

7. To return to the Arrange window, click on the “Arrange” button on the 
Transport Bar, or press [Return].
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Setting up the Metronome Click and selecting a tempo
When you record audio, you don’t have to use a metronome, or even any specific 
tempo. However, it is often practical to select a correct tempo before starting to 
record, since this will let you add MIDI music easily later on. To help you keep time 
when recording, you use the Metronome Click function. First, you need to set it up:

1. Pull down the Options menu and select “Metronome...”.
The Metronome dialog opens.
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2. Make sure that “Precount” and “Beep” are activated.
When “Precount” is activated, the metronome will give you a “count in” before 
you start recording. You can select the length of the count in, by entering a 
value in the “Bars” field below.

3. Click OK.
Now you need to set a suitable time signature and tempo for your music:

4. Make sure the Master button on the Transport Bar is not activated.

5. Set a Time Signature of your choice on the Transport Bar.
You can change each of the two Time Signature values separately to get Time 
Signatures from 1/2 to 16/16.

Tempo integer Time Signature

The Master button
turned off

Tempo fraction
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6. Activate the Click button on the Transport Bar and click on the Play but-
ton.
You will hear a metronome click sound.

7. Adjust the Tempo on the Transport Bar, until it feels right.
The Tempo setting is divided into integer (“coarse”) and fraction (“fine”) values. 
We suggest you start with the integer part and use the fraction value only for 
fine-tuning.
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Recording from a specific point
Now that you’re all set, it is time to actually record!

1. Set up the Left Locator to where you want the recording to start and the 
Right Locator to where you want it to end.
The Locators are markers, visible as two lines stretching over the Arrangement 
and with an “L” and an “R” flag in the ruler. 

You move them by dragging the flags in the ruler, or by changing the Locator 
values on the Transport bar (for other ways of setting the Locator positions, 
see page 82).

● If you are not sure how long you want the recording to be, or prefer to deac-
tivate recording manually, set the Right Locator to a very large value so that 
you will not intentionally reach it while recording.

Left Locator Right Locator
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2. Make sure that the Cycle button (the middle blue button on the Transport 
Bar) is deactivated.

3. Click the Record button.

4. After the count-in, start performing.

5. When you are done, press Stop.
The program will now calculate an image file so that a waveform can be dis-
played. Depending on the length of your recording, this may take a few sec-
onds, during which a dialog box shows the progress of the calculation. When 
finished, a Part will appear on the Track:

A Part on a Track

6. Click Stop again to return to the beginning of the recording, and click 
Play to listen to your performance.

Cycle turned off
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Redoing the Recording
There are three ways you can redo a recording that you are not satisfied with:

Recording again over the existing Part

If you simply record again on the Track, you will get a new Part which overlaps the 
previous. The Track will play back fine, but you will be wasting hard disk space 
with unused recordings.

Using Undo

If you press Undo after Recording, the Part you just created will disappear and you 
can record again. However, the audio file still resides on the hard disk and there is a 
segment for it in the Pool (see page 169 for details). You can always delete unused 
segments later, so this is nothing to worry about.

Deleting the Part

The final option is to manually delete the Part and then record again on the Track.

• If you delete the Part with the Eraser (or by selecting it and clicking 
[Backspace]), it disappears, but the segment and the audio file are not 
deleted (just as when you use Undo, see above).
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• If you select the Part, hold down [Command] and press [Backspace], a 
dialog appears, asking you if you also want to delete the audio file. To do 
this, click OK.
This is the method to choose if you are sure you permanently want to delete 
the recording.
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Recording more on the same Track
To record more on the same Track, proceed as follows:

1. Move the Left Locator to the next position where you want to start 
recording.
This can be at a “free” area on the Track, or at some place where something is 
already recorded, as described below.

2. Move the Right Locator to where you want the recording to stop.

3. Activate recording just as you did the first time on the Track.
A new file is automatically created for you, as described below.

About overlap

When you record again, where something has already been recorded on the Track, 
you will get a new Part which overlaps the previous one(s). When you play back, 
only the Parts that you can see are played back. Let’s say the Track contains a long 
Part, and a shorter Part is recorded “on top of” and in the middle of the longer one. 
When the Track is played back, you will hear the first Part (the longer one) up until 
the start of the shorter Part. The short Part will then be played until its end and then 
you will hear the end of the longer Part.

During the “riff” Part, the “guitar” Part is silenced.
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Recording the Next Track - Overdubbing
Recording the next Track is done just as with the first. Just select another Track, 
name it and record as described on page 44. When you activate recording, you will 
hear the previously recorded Tracks together with the performance you are cur-
rently recording.

Activating Recording from Play mode - Punch In and Out
If you have used multi-track tape recorders you will know about a technique called 
punching in. This is when you activate recording while the tape is rolling. If for ex-
ample you have made a mistake in the middle of a chorus, you can play back from 
the beginning of the chorus and just before the flawed section, punch in and replace 
that section with a new performance.

Punch out is when you deactivate recording without stopping playback. If – in the 
example above – the chorus is followed by a verse which is perfectly OK, you would 
punch out at the end of the chorus so that you don’t record anything on the verse.

In Cubasis AV, the following guidelines apply:

• Cubasis AV always punches out automatically at the Right Locator.
This means, that if you are recording and the Song Position passes the Right 
Locator, recording is automatically deactivated.
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• You can punch in and out manually on Audio Tracks, by clicking the 
Record button (or pressing [*] on the numerical keypad) in play mode.
However, you cannot punch in and out repeatedly without stopping playback 
in between. This is true no matter which method you use for activating 
recording.

The same is true for switching Tracks while recording. If you do this, recording is 
disabled (but playback continues). To activate recording again, you have to stop 
first.
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Preparations

Activate MIDI Thru!

Cubasis AV is best used with MIDI Thru activated and the connected MIDI sound 
source in Local Off-mode. Therefore:

● Make sure that MIDI Thru is activated on the Options menu.

Selecting a MIDI Track for recording

There are sixteen MIDI Tracks in Cubasis AV, located below the eight Audio Tracks 
in the Arrange window. Each Track has its own MIDI Channel (1 - 16, indicated by 
the number in the "Chn" column). If you have a MIDI sound source that can play 
different sounds for different MIDI channels (usually called a "multitimbral" sound 
source), you can control up to 16 different MIDI sounds at once, one for each MIDI 
Track.
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First, you need to select a Track to record on:

1. In the Track list in the Arrange window, click on the name of one of the 
Tracks. 

At this stage, you can name the Track if you want to. It is often very practical to use 
a Track name that corresponds to the music or the sound you want to record on the 
Track:

2. Double click on the Track name in the list.
A name box opens.

3. Type in the desired name of the Track and press [Return].

The MIDI Tracks
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Selecting a sound for the Recording

If you use a typical multitimbral MIDI sound source, it can receive MIDI signals on 
16 different MIDI channels. For each channel, you can select a sound (“Programs”, 
“Presets”, “Patches”, “Tones”, “Voices” or whatever they might be called). Since 
MIDI channel 1-16 correspond to MIDI Track 1- 16 in Cubasis AV, you can set up 
the MIDI sound source so that you have different sounds for each MIDI Track.

There are two ways to select a sound for the Track’s MIDI channel:

Using the Instrument’s front panel

Normally you can select sounds – for each MIDI Channel – directly from the front 
panel on the instrument. If you choose this method, please refer to the instrument’s 
operation manual for details.

Using the Inspector

You can also select sounds directly in Cubasis AV.

● Your instrument must be set up to receive MIDI “Program Change” messages 
for this to work. Refer to the instrument’s operation manual for instructions on 
how to do this.

1. Click on the Inspector icon, below the Track list.
The Inspector appears.
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2. Click in some empty part of the Part Display (the area to the right of the 
Track list).
This is to make sure no Part is selected. The top text in the Inspector now says 
”Trackinfo” and below this, the name of your Track is displayed. This is your 
verification that the Inspector actually shows the settings for the right Track 
(the selected one).

3. If you use a General MIDI compatible sound source, click on the "GM 
Name" field to pull down the General MIDI program name pop-up menu.
The pop-up menu consists of 16 submenus, each containing 8 GM instruments. 
Selecting one of them will send out the appropriate MIDI Program Change 
message to your MIDI sound source.
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4. If you use a non-GM sound source, you can instead enter a Program 
Change number in the Prg value field.
In MIDI, Programs are always numbered continuously, and in Cubasis AV 
they are numbered from 1 upwards. Your instrument might use some other 
numbering scheme, so you might need to experiment a bit before you get the 
right sound.

Changing this setting 
sends out MIDI 
Program Change 
numbers.
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Click

Recording into a sequencer is done in time with a metronome click. So, to make 
sure you hear the metronome, check that the Click button is activated. If it isn’t, 
click on it.

This activates a click directly from the computer. If you want a MIDI metronome, 
check the Metronome dialog (reached from the Options menu, see page 366).

Tempo and Time Signature

To set a Tempo and Time Signature for your recording, proceed as follows:

1. Make sure the Master button on the Transport Bar is turned off.
You need to activate the Master (Track) if you want tempo changes in your 
song. Otherwise it is best turned off. See page 76.

2. Set a Tempo and a Time Signature of your choice in the Tempo/Time Sig-
nature box on the Transport Bar.

Click activated on 
the Transport bar
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Recording from a specific point
1. Set up the Left Locator to where you want the recording to start and the 

Right Locator to where you want it to end.

2. Click on the Record button or press [*] on the numeric key pad.

3. After the count-in, start playing your MIDI instrument.

4. When you are done, click the Stop button.
A Part appears on the Track.

5. Click Stop again to return to the beginning of the recording, and click 
Play to listen to what your performance.

Now all you have to do to hear what you recorded, is to click the Play button, or 
press [Enter] on the numeric key pad.

Activating Play
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Redoing the Recording

If you aren’t satisfied with the recording, you can try either of the two following 
methods:

Using Undo

If you haven’t made any changes to the Arrangement since you recorded, you can 
simply Undo the recording by selecting Undo from the Edit menu. Remember you 
can only Undo your last action.

Deleting a Part

You can delete a recording (a Part) by clicking on it and selecting Delete from the 
Edit menu or pressing [Backspace].

Recording more on the same Track

If you wish to record more on the same Track, proceed as follows:

1. Set up the Left Locator to where you want the new recording to start and 
the Right Locator to where you want it to end.

● You cannot activate recording if the Locators are positioned in “reverse order”.
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2. Activate Recording by clicking on the Record button or pressing [*] on 
the numerical keypad.

You will hear a count-in just as you did the first time, and then recording starts from 
the Left Locator position.

When you have finished recording, you will probably get a new Part, after the first 
one.

The second Part appears after the first.

You may also start recording from Play mode ("Punch In"), see page 63.

How Parts appear when you record

When you record, the following rules apply:

• Recording from one point to another creates a Part that spans these two 
points.

• Recording again on the same Track, between the same points or within 
the Start and End points of the existing Part creates no new Part. 
The music is added to the existing.

• If “Prerecord” in the Metronome dialog box is active (see page 364), 
recording during the Precount will extend the Part to the left. 
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• In other cases (like starting recording in an empty section of the Track, 
recording over Parts and recording out of existing Parts into empty areas 
of the Track), new Parts are only created where there weren't any before. 
An example might clarify this: 

You have an existing Part starting 
at 5.1.0 and ending at 8.1.0.

You start the new 
recording at 3.1.0 and 
end at 10.1.0.This creates a new Part starting at 

3.1.0 and ending at 5.1.0...

...the old one between 5.1.0 and 
8.1.0 is kept, but music gets added 
to it...

...and finally there is a new part created 
between 8.1.0 and 10.1.0.
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Recording the next Track

To record on the next Track, proceed as follows:

1. Select the next Track by clicking on its name field.

2. Select a sound for this recording, just as with the first.
Again, this can be done either on the front panel of the instrument or from the 
Inspector - it all depends on your instruments and which method you prefer.

3. Set the Left Locator to the position where you want the recording to be-
gin, and the Right Locator to the position where you want it to automat-
ically end.

4. Activate Recording, wait for the count-in and start performing.
Now, if you have everything set up OK, you should hear your first Track while 
you record the second.

● If you activate the Preroll feature, you will hear the last bar(s) before the Left Lo-
cator played back instead of the metronome click count-in. This is described in 
detail on page 364.
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Activating Recording from Play mode - Punch In and 
Out

As with Audio Tracks, you can Punch In and Out on your MIDI recordings, following 
these rules:

• Punch In is done manually, by activating recording anytime during play-
back.

• Punch Out is either done manually, by deactivating recording without 
pressing the Stop button, or automatically, when the Song Position passes 
the Right Locator.

About punching in on long notes

When you activate recording in Cubasis AV, already recorded notes are never cut 
off, they will play to their end just as they did before you started this recording.

About punching in on Controller or Pitch Bend data

Watch out when punching in on recordings with Pitch Bend or Controller data (mod-
ulation wheel, sustain pedal, volume etc.), since this may lead to strange effects 
(hanging notes, constant vibrato etc.).
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5

Cycled Playback and Recording 5
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What can I do with the Cycle?
Cubasis AV can play back and record in a Cycle – a loop. You decide where the Cycle 
starts and ends by setting the Left and Right Locators. When Cycle is active you can 
repeatedly listen to a section of the Arrangement, and record, adding more on each 
lap etc. Cycled playback is also convenient when making adjustments in the Mixer 
windows.

Setting up the Cycle
1. Set the Left Locator to the position where you want the Cycle to begin.

2. Set the Right Locator to the position where you want the Cycle to end.

3. Click on the Cycle button so that it gets activated, or press [/] on the 
numeric key pad.

The Left and Right Locator

The Cycle button
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Playing back the Cycle
When you play back with Cycle activated, the section between the Locators gets 
repeated indefinitely.

You can use any or all of the functions while the program is playing back. This fact 
allows you to use Cycled playback for a number of things, many of which you will 
learn about later in this manual:

• Rehearse a part before recording.
• Try different settings in the Mixer windows.
• Mute Tracks to try out variations on an Arrangement.
• Make adjustments in the Inspector, apply Quantize etc.
• Make adjustments to the sounds in your instruments or try out a Track with 

another sound.
• etc.
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Recording in Cycle Mode
Cycle Recording works differently for MIDI Tracks and Audio Tracks. The text 
below describes the procedure and results of MIDI Cycle Recording; Audio Cycle 
Recording is described on page 69.

With MIDI Tracks

When you record in Cycle mode on a MIDI Track, you can add new notes to the Part 
for each Cycle “lap”. You may for example use it when recording a drum pattern - 
record the kick drum on the first lap, the snare on the next and so on.

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on.

3. Click the Record button.

4. After the count-in, start playing.

5. Keep playing on each lap of the Cycle until you are done.
The new notes are added to the existing ones.
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● If you punch out manually by clicking the Record button after each recorded 
lap, you can listen to the latest recording, and use the Undo command to delete 
it if you are not satisfied. Then, simply punch in again and try again on the next 
lap.

6. Stop Cubasis AV or punch out manually by clicking on the Record button 
again.

Switching MIDI Tracks while recording

You can record on more than one Track while in the Cycle (this only works with 
MIDI Tracks):

1. Set up a few Tracks on which to record. Also set up the instrument(s) so 
that they play the right sounds on these MIDI Channels.

A few Tracks set up for recording a four bar groove.

2. Enter recording in Cycle mode.
Record on the first Track.
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3. Without stopping, select a new Track in the Track list or use the [↑ ] and 
[↓ ] keys to step through the Tracks.
Selecting a new Track automatically routes your playing to the new sound.

4. Record on this second Track as with the first.

5. Keep recording on different Tracks until you are finished.

6. Stop Cubasis AV or punch out manually.

With Audio Tracks

When you record in Cycle mode on an Audio Track, the new music is not simply 
added to the old. Instead you will get a separate “take” for each recorded lap, and 
can decide afterwards which one to use. Let’s say that you want to record an instru-
mental solo passage or a lead vocal:

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on.
Remember to name the Track, to make it easy to find the recorded audio files 
later on.

3. Click the Record button.
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4. After the count-in, start performing.
For each lap, try a new take, until you are satisfied.

5. Stop recording.
If you listen to the recording, you will only hear the last recorded lap. To select 
another take, you need to open the Pool:

6. Click on the Pool button on the Transport Bar.
The Pool window opens. This window (described in detail on page 168) con-
tains a list of all audio files used in the Song. 

7. Locate the file (one of the files with the name of the Track you recorded), 
and click on the triangle to the left of the name, so that it points down.

A number of names appear below the file name. These are segments, sections 
of the audio file. You will find one segment for each “take” you recorded, and 
one segment that covers the whole audio file (all takes).

8. To listen to one of the takes, simply press the mouse button with the 
pointer on the Speaker symbol to the left of the segment.
You will hear the segment played back as long as you keep the mouse button 
pressed.
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9. To try one of the takes in the Arrangement, you need to arrange the 
windows on the screen, so that you can see the Pool window and the Part 
display in the Arrange window at the same time.

10.Then click on the segment name, drag the segment into the Arrange 
window and release it on the selected Audio Track, at the Left Locator 
(on top of the original Part).

A new Part is created, obscuring the original Part.

11.Try the different takes this way, until you find the best one.
If you want to “go back” to a take you previously tried out, you can either 
drag it from the Pool again, or delete the Parts that are “on top” of it in the Part 
Display, using the Eraser tool.
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Playback, Tempo and the Transport Bar6
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The Transport Bar
Below, you will find a brief description of each control on the Transport Bar:

Punch Out point 
and end of Cycle

Record start point 
and beginning of 
Cycle

Handle
(move)

Close box

Song Position Time SignatureTempo

RecordRewind Forward Stop Play
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Hiding and showing the Transport Bar

To hide the Transport Bar, either click its Close box or select “Hide Transport” on 
the Windows menu. To bring it back, select “Show Transport” from the Windows 
menu.

When the Transport Bar is hidden, you can still access all its functions via the compu-
ter keyboard. See below for a list of Transport Bar commands.

Moving the Transport Bar

You can put the Transport Bar anywhere you want it, by dragging the handles. It 
will always stay on top of the other Cubasis AV windows.

Flashes when MIDI 
signals are sent from 
Cubasis AV.

Turns the Metronome 
On/Off.

Turns the Master 
Track On/Off.

Turns Cycle On/Off.

Flashes when MIDI 
signals are received 
by Cubasis AV.
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The Numeric Key Pad
The numeric part of the computer keyboard is used for many Transport Bar opera-
tions. Some of these are described in more detail later in this chapter.

The Space bar also functions as Stop button.

num
lock = / *

7 8 9 –

4 5 6 +

1 2 3

0 , enter

Record

Lower Tempo 

Raise Tempo 

Play

Cycle On/Off Rewind
Fast Forward

Go To 

Go to 

Go To 

Go To 

Cue Point

last Stop

Left Locator

Right Locator

Stop 
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Basic Tempo and Time Signature Handling

Transport Bar and Master Track Tempo

There are actually two sources for the tempo in Cubasis AV:

• When the song uses a steady tempo throughout, you don’t need to use the 
Mastertrack and can have the Master button on the Transport Bar turned off 
and simply set the right tempo directly on the Transport Bar. The tempo can 
be adjusted at any time, even while playing back.

• When the song contains tempo changes, you need to use the Master Track, 
(which is Cubasis AV’s tempo Track and more! See the chapter “The Master 
Track”). For those tempo changes to actually “happen” on playback, the Mas-
ter button on the Transport Bar must be activated. This is all discussed in the 
chapter “The Master Track”.

The Tempo setting 
on the Transport 
Bar is used.

The Tempi set on 
the Master Track 
are used.
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Setting the Transport Bar Tempo

The tempo on the Transport Bar is adjusted like any other value (see page 21 in this 
book). The value is in BPM (Beats Per Minute). The integer and fraction part can 
be adjusted separately, if necessary.
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Setting the Song and Time Position

Using Fast Forward and Rewind

The Song Position can of course be moved using Fast Forward or Rewind. If you 
hold down [Shift] while clicking the button, Rewind/Fast Forward is much faster.

By moving the Song Position in the Ruler

You can drag the Song Position Pointer directly in the ruler simply by pointing at 
the triangle, pressing the mouse and dragging left or right.

Dragging the Song Position.

Rewind Fast Forward
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By clicking in the Ruler

If you click somewhere in the ruler, the Song Position Pointer is moved there.

About the Snap Value

When you change the Song Position in the ruler, the Snap value helps you find exact 
positions quickly. It does this by limiting the possible points for positioning to Bar, 
half note, quarter note, etc. Snap can also be set to Off; then all movements are unre-
stricted.

The Snap value is set with the Snap pop-up at the top of the Arrange window.

Value Description

Off Any position can be used.

Bar Movement is restricted to exact bar lines.

1/4 to 1/16 Movement is restricted to the selected note 
value.

Click in the ruler... ...to move the Song Position Pointer.

The Snap pop-up
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Changing Position values on the Transport Bar

You can adjust the Position values on the Transport Bar as described in the chapter 
“Basic Methods”. The Song pointer is moved accordingly.

If Snap is set to Bar...

...the Song Position can only be 
dragged to exact bar lines.

If Snap is set for example to 1/4...

...the Song Position can be put 
on any quarter note position.
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Making relative Position changes

If you double click on either position value and enter a new one, preceded by a “+” 
or “–” character, the song position is changed accordingly.

Double click...

...enter a value 
preceded by 
+ or – ...

...and the value 
gets added to the 
existing position.
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Returning to the beginning of the Song

If the Song is stopped and you click the Stop button again (or press [0] on the numeric 
key pad), the following happens:

• The Song Position is moved to the Left Locator.
• If the Song Position is already at the Left Locator or to the left of it, the Song 

Position is moved to the beginning of the Song.

This means that you can always click twice on the Stop button to return to the be-
ginning of the Song.

Going to the last Stop Position

If you press [9] on the numeric key pad, the Song Position moves to the place you 
last stopped at.

Moving to the Locators

• If you press [1] on the numeric key pad, the Song Position is moved to the Left 
Locator.

• If you press [2] on the numeric key pad, it is moved to the Right Locator.
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Using Cue Points

Cue points are used to quickly locate to any position. If for example you often find 
yourself jumping to the beginning of the first chorus, set up that position as a cue 
point.

Programming Cue Points

1. Set the Song Position to where you want the Cue Point to be located.

2. Hold down the [Shift] key and press any of the keys [3] to [8] on the 
numeric key pad.
The key is now programmed with that position.

Locating to Cue Points

If you press any of the keys [3] to [8] on the numeric key pad, the Song Position is 
moved to the position programmed for that key.
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Cueing
Cueing is when you fast forward through the music while playing it. You might 
have done this on a multi-track tape recorder. The big difference with Cueing in 
Cubasis AV is that the music is played back with normal pitch.

● Cueing only works with MIDI Tracks; Audio Tracks are silenced during Cueing.

1. Hold down the [Command] key.

2. Click and hold down the mouse button with the pointer over the Fast 
Forward button.

• To change the speed of cueing, drag the mouse left/right.
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Locators
As described in the previous chapters, the Left and Right Locator are crucial for 
recording, setting up a cycle, etc. There are several ways of setting the Locator 
positions:

Setting the Locators by dragging in the Ruler

1. Set the Snap value.
The Snap value restricts the positions to which you can move the Locator, as 
with the Song position, see page 79.

The Snap pop-up

2. Point at the desired Locator flag in the ruler, and drag left or right.

Dragging the Left Locator

3. Release the mouse button.



Setting the Locators by clicking in the Ruler

1. Set the Snap value.
See above.

2. If you wish to position the Left Locator, hold down the [Option] key. 
To position the Right Locator instead, hold down the [Command] key.

3. Click somewhere in the ruler.
The Locator appears at that position. 

Setting the Locators on the Transport Bar

You can also adjust the Left and Right Locator position by changing the numerical 
values in the Locator boxes on the Transport Bar.

Making relative Position changes

Just as with positions (see page 81 in this book) you can double click and enter a 
new value, preceded by a “+” or “–” character. When you hit [Return] the Locator 
is moved relative to its current position.
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Mute and Solo 7
- 87 - 



What is Muting?
Using the Mute function you can silence some of the music without actually deleting 
it. This is useful in many situations; you may for example want to try out different 
variations of an Arrangement by muting some parts of the music, or listen only to the 
rhythm section of a song etc.

Muting a Track

To “unmute” a Track, simply click on the black dot.

● If any notes are sounding at the moment you Mute a Track, they are allowed 
to play until their end.

Clicking in the Mute column...

...silences the Track. The black dot 
indicates that the Track is Muted.
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What is Solo?
The Solo function works as an “inverted” Mute - that is, if you Solo a Track, all 
other Tracks get Muted. This is useful if you want to listen closely to the contents of 
a Track, and don’t want any other music to interfere. Solo a Track like this:

Click on the Solo button in the upper left 
corner of the Arrange Window to activate Solo.

The highlighted Solo 
button indicates that 
Solo is activated.

All Tracks except the 
currently selected, get 
Muted.

If you select another Track, 
it will get Soloed instead.
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Instead of clicking on the Solo button, you can press [S] on the computer keyboard. 
You can unmute one or more Tracks while in Solo mode if you want to hear, for 
example, just how two or three Tracks sound together.

To deactivate Solo, click on the Solo button (or press [S]) again. All Tracks will return 
to the Mute status they had before Solo was activated.
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Introduction
This chapter describes the general procedures of adjusting levels, pan, EQ and ef-
fects, to create a final mix of the eight Audio and sixteen MIDI Tracks. 

Mixing is done in two different windows in Cubasis AV, the Audio Mixer and the 
MIDI Mixer.

About the differences between the two Mixers

It is important to understand the difference between the two Mixers:

• The Audio Mixer affects the actual audio playback.
For example, the volume faders in the Audio Mixer will really attenuate or 
boost the volume of the audio, and the pan controls will determine where in 
the stereo image (left - middle - right) the sound appears when you play it 
back. 
This also means you have to be careful when raising the channel volumes - 
it’s fully possible to cause distortion by setting to high levels. If this happens, 
simply lower the faders until the distortion disappears.

• The MIDI Mixer sends out MIDI messages to the connected MIDI sound 
source.
For examples, the volume faders in the MIDI Mixer send MIDI Volume 
messages (Controller 7) on each channel, and the pan controls send MIDI Pan 
messages (Controller 10).
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● For this to work properly, your MIDI sound source must be able to receive the 
appropriate MIDI signals. Most modern MIDI instruments are, but if you’re in 
doubt, consult your instrument’s documentation.

Opening the Mixers
On the Transport bar you will find one button for each of the Mixers. Clicking these 
opens the corresponding window.

Click the AudioMix button to open the Audio Mixer, and the MIDIMix button to open the 
MIDI Mixer.
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General Mixing Procedures
As you see, the two Mixer windows look much the same, apart from the labels on 
some of the controls, and the amount of channels. Even though the two Mixers have 
totally different functions (one affecting the audio being played back, the other 
sending out MIDI messages), the controls are handled in the same way for both 
Mixer windows:

The Channel Faders

These work just like volume faders on a normal mixer. Just click and drag the fader 
handles. 

• If you click directly anywhere on the fader, the fader handle is immedi-
ately set to where you click.

• If you hold down [Command] and click anywhere on a fader, it is auto-
matically set to the value “0”.
For Audio Tracks, the level “0” means the recorded signal is neither boosted 
nor attenuated. For MIDI Tracks, this means a MIDI volume value of 100 (out 
of 127) is sent out.
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The Knobs

These include Pan, EQ and Effect controls. There are two ways to change their 
settings:

• Press the mouse button with the cursor on the knob and drag, “turning” 
the knob around.

or

• Click directly on the knob, at the position you want to turn it to.
The knob is immediately “turned” to where you click.

Performing the Mix
To mix, simply play back the music and adjust the controls in each window to your 
liking.

If you want dynamic changes, for a example a fade out or in at some point in the 
song, you can use the Volume and Fade settings in the Inspector for each Audio Part 
(see page 155).
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The Audio Mixer Controls
Below follows a description of the controls in the Audio Mixer window:

For each Channel

Control: Description:

Meters These show the playback level for the channel. To avoid distor-
tion, you should make sure the meters don’t regularly go into 
the orange field (if they do, lower the volume fader for the 
channel).

Fx This is used to set how much of the selected effect (see below) 
that should be applied to this channel.

Treble This is a tone control, used to increase or reduce the high fre-
quency content of the audio.

Bass This is a tone control, used to increase or reduce the low fre-
quency content of the audio.

Pan For Audio Tracks recorded in mono, this is used to position the 
audio in the stereo image (left/middle/right). For stereo Audio 
Tracks, the Pan knob serves as a stereo balance control.

Volume This is used to adjust the level of the audio channel. The fader 
ranges from - ∞ (the channel fully silenced) through 0 (no at-
tenuation or boost) to +6 (the channel boosted by 6 dB).
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● The volume fader settings are relative to any Volume settings made for each 
Part in the Inspector! This means that if you have set the Volume for a Part to 
64 (about half the full value), this will be the volume you get with the mixer 
fader set to 0.

Master Section

Control: Description:

Meters The meters show the overall output level for the left 
and right channel. As with the channel meters, these 
meters should go into the orange field only occasion-
ally.

Clip If the Clip indicator lights up, the sound will be dis-
torted and you should reduce the master level (see 
below). The Clip indicator will not go out of itself, 
you have to click on the indicator to “reset” it.

Effect 
switches

This is used to decide what type of effect to use on 
those channels where effect is applied with the FX 
knob. All channels share one effect. The six effect 
settings are described below this table.

Volume This is used to adjust the overall output level from all 
the Audio Tracks.
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About the Effects

The Audio Mixer contains a global Effect switch, with a choice of six effect varia-
tions. With the FX knobs, you can decide how much effect should be applied to each 
channel. The following six effects are available:

Reverb 1 A short reverb, simulating the sound of a medium-small room.

Reverb 2 A longer reverb, simulating the sound you would get in a large hall.

Reverb 3 A very long and deep reverb, suitable for special effects.

Echo 1 A classic repeat echo with a relatively short delay time.

Echo 2 A special setup with double delay times for extra deep echo.

Echo 3 As Echo 2, but with longer delay times.
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The MIDI Mixer Controls
Below follows a description of the controls in the MIDI Mixer window, from left to 
right.

● Please note that some of the controls are only available in GS or XG mode, 
and require that your instrument is GS or XG compatible. See page 106.

Effect selectors

These are three green fields located to the left of the channel sections, that indicate the 
functionality of the three top rows of knobs. Two of the fields also serve as pop-up 
menus, for selecting effects in GS/XG Mode.
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The Reverb Type pop-up

The contents of the pop-up menu differs depending on the setting of the Mode pop-up 
to the right in the MIDI Mixer window:

To select a reverb type in GS or XG mode, position the pointer on the green Reverb 
Type field, press the mouse button and select one of the options on the pop-up menu 
that appears. A MIDI Message is sent to your connected sound source, and the 
name of the selected reverb type is shown in the green field, as a label for the top 
knob row.

The reverb type pop-up in GS mode

GM Mode No reverb selection available. The green field is labelled “OFF”, 
and the top row of mixer knobs has no functionality.

GS Mode The pop-up contains a selection of six reverbs and two delays, 
according to the GS specifcations.

XG Mode The pop-up contains a selection of eight different reverb types, 
according to the XG specifications.
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The Chorus Type pop-up

The contents of the pop-up menu differs depending on the setting of the Mode pop-up 
to the right in the MIDI Mixer window:

As with the Reverb Type pop-up, the name of the selected chorus type is shown in 
the green field, as a label for the second row of knobs.

The Chorus Type pop-up in XG mode

GM Mode No chorus selection available. The green field is labelled “OFF”, and 
the second row of mixer knobs has no functionality.

GS Mode The pop-up contains a selection of chorus, flanger and short delay 
effects, according to the GS specifcations.

XG Mode The pop-up contains a selection of chorus, celeste and flanger effects, 
according to the XG specifications.
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The Filter label field

The third green field has no pop-up menu. It simply serves as a label for the third 
row of knobs in the MIDI Mixer. The label changes automatically depending on 
which Mode is selected to the right in the window:

GM Mode The field is labelled “OFF”, and the third row of mixer knobs has 
no functionality.

GS or XG Mode The field is labelled “Filter”, indicating that the third row of knobs 
is used to control the Filter cutoff (brilliance) in the connected 
sound source.
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Controls for each Channel

Control: Description:

Meters These show the playback level for the channel (actually the 
velocity values of the notes being played).

Reverb
Amount

Only available in GS or XG mode. Used to set how much of 
the selected reverb effect (see above) should be applied to this 
channel.

Chorus 
Amount

Also only available in GS or XG mode. Used to set how much 
of the selected chorus effect (see above) should be applied to 
this channel.

Filter Also only available in GS or XG mode. Used to adjust the tim-
bre of the sound. Turn the knob to the left for a darker sound, to 
the right for a brighter sound.

Pan This is used to position the sound in the stereo image (left-mid-
dle-right).

Volume This is used to adjust the level of the channel’s sound.
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The Prog Name field

At the bottom of each Mixer Channel “strip”, there is a field labelled “Prog”. Clicking 
on this field opens a GM Program Name pop-up, just like in the Inspector. Use this to 
select a sound for each MIDI Channel/Track.

Please note that Channel 10 is always used for drums in General MIDI. Therefore, 
you cannot select regular instruments for this channel. In the GS and XG Modes, 
however, you can use the Prog pop-up to select one of nine different Drum Kits for 
Channel 10.
- 104 - 



Master Section

The controls in this section (in the rightmost area of the Mixer) are common to all 
sixteen MIDI channels.

Meters

These show the overall “output level” from all the Tracks (actually, the velocity 
values).

The Master Volume fader

Governs the total volume for all MIDI Channels. The Master fader does this by 
scaling the MIDI Volume values set with the Channel Faders. Therefore:

• For the channels to get the exact volume values set with each Channel 
Fader, the Master fader should be at its top position.
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The Mode pop-up

This setting determines which functions are available in the MIDI Mixer. Set this to 
the type of instrument you have:

• If your MIDI sound source doesn’t support any of these standards, you 
may still be able to use the MIDI Mixer for basic purposes like setting 
channel volume values. Refer to your instrument’s documentation.

GM Stands for General MIDI, a standard that is supported by a lot of instruments. 
This is the basic Mixer mode, that allows you to set volume, pan and Program 
Change for each channel.

GS This is a standard used by some Roland instruments. It has the mixer features of 
GM, but adds effects, filter control and selection of drum kits for Channel 10.

XG This is a standard used by some Yamaha instruments. It has roughly the same 
mixer features as GS, but with a different effect and drum kit selection.
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The Reset Button

Some instruments may have specific GM, GS or XG Modes of their own. This button 
is used to “tell” the instrument to enter the Mode currently set in the Mode pop-up 
above, and to reset certain parameters to their normal values.

• Make it a habit to click the Reset button at the start of a recording session, 
or whenever you change Modes in the MIDI Mixer.
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About Parts and Arranging
As you have already seen, a Cubasis AV Arrangement is roughly structured in two 
“levels”: Several Tracks, each containing a number of Parts . This chapter is about 
arrangement editing - in other words, re-arranging Parts. This is done in the right 
part of the Arrange Window, the area called the Part Display.

The Arrange Window with the Part Display on the right side.
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About the Tools

When manipulating the Parts, you will make use of the various tools in the Arrange 
Window’s Toolbox. 

• Select tools from the Tools menu, from the Toolbar or directly from a 
free-floating Toolbox, as described on page 15. 
The pointer takes on the appearance of the selected tool when moved into the 
Part Display.

The tools are all described later in this chapter, in the contexts in which they are 
used.

The Arrow tool The Pencil tool

The Eraser tool The Scissors tool

The Magnifying Glass The Glue tube
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About Overlapping Parts

Parts on the same Track might overlap or be completely on top of one another. 
However, there is a big difference between the two types of Tracks:

• On Audio Tracks, only the Parts that you can see are played back.
This means that if two Parts overlap, the section that is obscured will be silent.

• On MIDI Tracks, all sections of all Parts will be played back, no matter if 
they are visible or not.
You can make good use of this feature in many ways:

• Parts which start with an upbeat can overlap the end of the previous Part.
• Small drum ornaments (such as cymbal crashes) can be created as separate 

Parts and just be put on top of the basic beat Part.
• Duplicate Parts which are used to create delay effects, double sounds and so 

on, can be put on top of the original Parts.
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Creating Parts
Normally, Parts are created when you record something. However, you may want to 
create empty MIDI Parts and add notes and other Events in one of the MIDI Editors, 
for example using Step Recording. There are four ways to create an empty MIDI 
Part:

• By double clicking with the Arrow tool in any empty area between the 
Left and Right Locator, in the Arrange window.
The new Part winds up between the Locators, on the Track upon which you 
clicked.

• By selecting Create Part from the Parts menu.

• By pressing [Command]-[P] on the computer keyboard.
In these two cases, the new (empty) Part winds up on the active Track beginning 
at the Left Locator and ending at the Right Locator. 

• By drawing it with the Pencil tool.
In this case, the Track, position and length of the new (empty) Part depends on 
your drawing and the Snap value (see page 120).

● A directly created Part never replaces an existing Part, but might overlap one.

The created Part gets the name of the Track, but you can easily change the name, as 
described on page 132.
- 112 - 



Selecting Parts
You have to select a Part in order to move, delete or in any way manipulate it. 
Selecting a Part can be done in several different ways:

By clicking

Clicking on a Part with the Arrow tool...

...selects it...

...and deselects all 
other selected Parts.
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By shift-clicking

Clicking on a Part while 
holding down [Shift]... ...selects the Part.

The previously 
selected Part(s) 
remain selected.
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By using the computer keyboard

• If you hold down the [Shift] key, the previous Parts will remain selected.

Pressing the right 
arrow key on the 
computer keyboard...

...selects the next Part 
on the same Track.
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By enclosing them in a rectangle

...and drag the mouse with the button pressed. 
A dotted outline of a rectangle is shown.

When you release the mouse button, all Parts that were 
enclosed or “touched” by the rectangle, become selected.

Press the mouse button with the pointer somewhere 
in an empty part of the Part Display...
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If you hold down [Shift] when you start to drag, you don’t have to have the pointer 
in an empty area, you can start with the pointer positioned over a Part.

Selecting all Parts

On the Edit menu you will find an item called “Select All”. This item selects all 
Parts in the Arrangement.

• You can also select all Parts by pressing [Command]-[A] on the computer 
keyboard.

Selecting all Parts on one Track only

If you hold down [Shift] on the computer keyboard and double click on a Part, all 
Parts on that Track get selected.
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Deselecting Parts

There are two principal ways to deselect already selected Parts:

1. If you hold down [Shift] and click on a Part...

...the Part gets deselected. The other selected Parts remain selected.
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2. If you instead click in some empty 
area in the Part Display...

...all selected Parts get deselected.
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Manipulating Parts

About the Snap value

When you are moving, duplicating or changing the length of Parts, the result of 
your actions depends on the Snap value. 

Pulling down the Snap pop-up menu.

This value determines the smallest distance you can move a Part. The table and figure 
below explains it more clearly:

Value Description

Off Any position can be used.

Bar Movement is restricted to exact bar lines.

1/2 to 1/16 Movement is restricted to the selected note value.
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If Snap is set to Bar...

...Parts can only be dragged to exact 
bar lines.

If Snap is set for example to 1/4...

...Parts can be put on any 
quarter note position.
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Moving Parts

You can move one or more Parts to a new position on any Track of the same type. 
Remember that the Snap value determines where you can place the Parts.

Press the mouse button with the Arrow pointer over 
the selected Parts you want to move. The pointer 
takes on the shape of a hand.

Drag the Parts to their new position...
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...and release the mouse button. The Parts are 
moved. Note that the relative distances 
between the moved Parts are kept intact.
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Duplicating Parts

To duplicate Parts, hold down the [Option] key on the computer keyboard and pro-
ceed exactly as when moving. You may move the duplicate to any position on any 
Track of the same type.

When you hold down [Option] and 
drag a Part to a new position...

...a duplicate of the Part, complete with 
contents, is placed at the new position.

The original 
Part is not 
affected.
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Another way of moving or duplicating Parts is to use Cut/Copy and Paste. These 
functions are described in the chapter “Basic Methods”.

Repeating Parts

You can repeat one or several Parts, on the same or different Tracks, using the Repeat 
function on the Parts menu:

1. Select the Part(s) you want to repeat.

2. Select the “Repeat...“ item on the Parts menu...
...or press [Command]-[K] on the computer keyboard.

3. Enter the desired number of copies in the dialog box that appears.
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4. Click “Do It”.
The selected Part(s) are repeated, and the copies are lined up "end-to-start" 
after the original(s). The Parts selected are treated as one block, so the relative 
spacing between the created Parts is determined by the beginning of the first 
selected Part and the end of the last.

Repeating Parts with the Pencil tool

If you hold down [Option] while lengthening a Part with the Pencil tool, new Parts 
will be created, all lined up end-to-start after the Previous Part. The new Parts will 
be copies of the original, including all Events and playback parameters.

The outline shown when you drag the Pencil can be thought of as a “frame”, that becomes 
filled with as many copies of the original Part as possible.
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Merging Parts

Merging one Part with another adds the contents of the first Part to the second. Of 
course, the two Parts have to be of the same type, i.e. both MIDI Parts or both Audio 
Parts. It is done like this:

1. Hold down the [Command] and [Option] keys on the computer keyboard.

2. Drag the first Part and release it on top of the other Part.
As when moving a Part, the result of this depends on the Snap Setting. The 
start and end points of the two Parts don't have to match at all.

● The dragged Part is not erased or even moved. A copy of its contents is made, 
and it is this copy that is merged into the other Part. 
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Changing the Length of a Part

If you have an excessively long Audio or MIDI Part, you can easily shorten it using 
the Pencil tool.

● For Audio Parts, this will only create a new shorter Segment, without destroying 
any actual audio data. For MIDI Parts, however, shortening a Part will erase any 
MIDI data in the section that is removed.

1. Select the Pencil tool.

2. Pull down the Snap pop-up menu and select an appropriate Snap value.
See page 120.

3. Click anywhere in the Part and keep the mouse button pressed.
A dotted frame appears, indicating the size of the Part.

4. Drag the Pencil to the left or right, and release the mouse button.
The Part is resized. You may use this method to make the Part longer as well, 
but this is not very useful, since there will be nothing in the lengthened section!

● If you make a MIDI Part shorter with the Pencil tool, some notes may con-
tinue to sound after the end of the Part. To make these notes end when the 
Part ends, select the Part, pull down the Parts menu and select Cut Notes.
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Splitting a Part

To split a Part into two, you use the Scissors tool:

1. Select the Scissors tool.

2. Pull down the Snap pop-up menu and select an appropriate Snap value.
See page 120.

3. Click in the Part where you want to split it.
You will get two Parts, with the same name as the original Part.

• If you hold down [Option] and click on a Part with the Scissors tool, the 
Part is split into several sections.
The length of the sections is determined by where you click in the Part:

Clicking with the Scissors on a Part, divides it in two.
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Joining Parts

You can use the Glue Tube tool to join Parts together into one:

1. Select the Glue Tube tool.

2. Click on a Part.
The Part is “glued together” with the next Part on the Track. The resulting, 
longer Part will have the name of the first Part. It is OK if there is a gap between 
the two Parts.

Before and after glueing two Parts together.

• If you hold down [Option] and use the Glue Tube tool, the Part you click 
on, and all following Parts on the Track, will be joined into one larger 
Part.
The resulting Part will have the name of the Part you click on.
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Scrubbing

With the Magnifying Glass tool, you can perform what is known as “Scrubbing”. 
This means that you can listen to the contents of each Part separately in Stop mode:

1. Select the Magnifying Glass.
From there on, the procedure differs for Audio Parts and MIDI Parts:

2. To monitor the contents of an Audio Part, click anywhere in the Part.
You will hear the contents of the Part played back, from the point where you 
clicked, for as long as you keep the mouse button pressed (or until the end of 
the Part).

When you press the mouse button, the pointer takes on the shape of a speaker.

3. To monitor the contents of a MIDI Part, drag the pointer forwards or 
backwards over the Part.
Notes and other MIDI Events will be played back according to how fast you 
drag the pointer.
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Renaming Parts

A Part can have a name consisting of up to 10 characters. When you create a Part by 
recording, it will get the name of the Track it resides on. There are two ways to 
change the name of a Part:

• Select the Part, open the Inspector and double click on the name field.
Type in a new name and press [Return].

• If it’s a MIDI part, you can also double-click on the Part.
A small name value box opens, where you can type in a new name. For MIDI 
Parts, the name is shown inside the actual box in the Part display.

Deleting Parts

There are several ways to delete a Part:

• Click on it with the Eraser tool.

• Select it and press [Backspace] on the computer keyboard.

• Select it, pull down the Edit menu and select “Delete Parts”.
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A note on deleting Audio Parts

Deleting an Audio Part with any of the above mentioned methods does not remove 
the actual audio file from the hard disk, or even from the list in the Pool. To actually 
delete the audio file from the hard disk, proceed as follows:

1. Select the Part.
If the audio file is used in several Parts in the Arrangement, you need to select 
all these Parts.

2. Hold down [Command] on the computer keyboard and press [Backspace].
A dialog appears, asking if you really want to delete the Audio file.

3. Click “Yes”.
The Audio file is removed from your hard disk.

● Keep in mind that a single audio file may be used by several Cubasis AV 
Songs! Make absolutely sure the audio file isn’t used in any other Song, before 
you delete it.
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Working with several Arrangements
You can work with more than one Arrangement within a Song, if you like. The 
different Arrangements could for example contain different versions of your music, 
or be used as “workbenches” for pieces that you later put together into one final 
Arrangement, etc.

Opening a New Arrangement

There are two ways to open a new Arrangement:

• Pull down the File menu and select “New”.

or

• Press [Command]-[N] on the computer keyboard.

The new, empty Arrangement opens in a window of its own.
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Selecting an Arrangement

Clicking on the Arrange button on the Transport Bar brings the most recently active 
Arrange window to front. To select another Arrangement, click on its window, or if 
it is obscured, pull down the Windows menu and select it from the Arrangement 
list.
- 135 - 



Copying Parts between Arrangements

If you want to move or copy Parts from one Arrangement to another, you use the 
standard Macintosh Cut, Copy and Paste commands on the Edit menu. This example 
describes how to copy a group of Audio and MIDI Parts to a new, empty Arrange-
ment:

1. Select the Parts to be copied.

2. Pull down the Edit menu and select Copy, or press [Command]-[C] on the 
computer keyboard.
If you want to move the Parts instead of copying, you should use the Cut com-
mand ([Command]-[X]) instead.

3. Click on the other Arrange window, so that it comes to front.

4. Move the Song Position pointer to where you want the first of the copied 
Parts to begin.
All other Parts will keep their distances in relation to the first Part.

5. Pull down the Edit menu and select Paste, or press [Command]-[V].
The Copied/Cut Parts are pasted into the new Arrangement, on their original 
Tracks, starting at the Song Position.
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Making a copy of a complete Arrangement

Sometimes you may want to make a duplicate of your whole Arrangement, for 
example if you want to have several versions to experiment with. Then, the easiest 
way is simply to save the Arrangement (using the “Save As...” item on the File 
menu) and open it again in new Arrange windows, as many times as you want. 
Refer to the page 330 for more information about these commands.

Naming the Arrangement

You can give names to each of your Arrangements simply by double clicking on the 
Arrangement name in the Title bar, and typing in a new name.

Renaming an Arrangement.

If you choose to save an Arrangement to disk as a separate file, then the name you 
give it while saving will be used as the Arrangement’s title next time you load it.
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Closing an Arrangement

You can close an Arrangement, if you don’t want to keep it or if you just want it to 
get out of the way:

1. Make sure the window is active (selected).

2. Click on the window’s Close Box, select “Close” from the File menu or 
press [Command]-[W].
A dialog appears:
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3. Select one of the options in the dialog.
The four options have the following functions:

Don’t Save Closes the Arrangement without saving it.

Save Opens a file dialog where you can save the Arrangement for later use. 
After saving, the Arrangement is closed.

Cancel Cancels the operation, i.e. the Arrangement is not closed.

Set Aside The window is closed, but the Arrangement is kept ,“hidden” in the 
Song. To open a set aside Arrangement, pull down the Windows 
menu and select it from the Arrangement list there.
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The Track Columns
The Track columns show names and settings for the Tracks. Some of these settings 
can be changed directly. 

Getting the Track Columns to appear

The Arrange Window is divided into two parts, the Track columns to the left and 
the Part display to the right. To get all of the Track columns to appear, press the 
mouse button with the pointer positioned above the Divider (the border between the 
two parts of the Arrange Window) and drag it as far to the right as possible. You 
should now be able to see all of the Track columns.

The Divider, dragged as far right as possible.
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Changing the order of the Track Columns

You can arrange the vertical columns in any order you like, by simply dragging the 
headings to the left and right, respectively.

If you drag to the left, the column will be inserted to the left of the column you 
"drop it on". If you drag to the right it will be inserted to the right of the column you 
"drop it on".

The Activity Column

This has the heading “A”. It shows if any audio or MIDI (depending on the Track 
type) is being sent out from the Track at the Moment. The width of each bar repre-
sents audio volume/MIDI note velocity.

● This column cannot be moved.
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The Class Column

This column (labelled “C”) helps you keep track of which Track Class each Track 
belongs to (Audio or MIDI Track). You cannot change this value.

The Mute Column

The Mute column is indicated by an “M”. By clicking in this column, you temporar-
ily “silence” the Track. A black dot is displayed in the column. To make the Track 
sound again, you just click in the Mute column again. This is described in detail in 
the chapter “Mute and Solo”.

Click in the "M" column...

...to Mute the Track. The 
black dot indicates that a 
Track is Muted.
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The Track Column

This column shows the Track's name. To enter or change a name, double click in 
this field for the relevant Track.

The Chn Column

The Chn column shows the Audio/MIDI Channel for each Track. This value shows 
you which Track goes to which channel in the Audio/MIDI Mixers. You cannot 
change this value.
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Using the Inspector

What is the Inspector?

The Inspector is a part of the Arrange Window. It contains a number of value- and 
name fields where you can change settings and properties of a Track, or individual 
Parts on a Track. 

• Audio and MIDI Parts have altogether different Inspector settings.
For Audio Tracks, the Inspector is also used to set up the Tracks for recording, 
as described on page 35.

There is one important thing to remember before you start working with the Inspector:

● The settings you make in the Inspector will only affect the material during 
playback. You don’t actually change the recorded data itself.
- 145 - 



When you play back notes 
from a Part...

...they pass through 
the Inspector...

...and are output, in this 
example transposed one fifth 
(i.e. seven semitones) upward.

The actual recorded material 
in the Part is not affected.
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Getting the Inspector to appear

You open the Inspector by clicking on the strip with the little Inspector Icon below 
the Track column, or by pressing [Option]-[I]. An area to the left of the leftmost 
column in the Track list appears. In this you find a number of value fields, name 
fields and buttons. These are described on the following pages.
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...to open the Inspector.

Click on the Inspector Icon...

To close the Inspector, click on the Inspector Icon again.
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Changing values in the Inspector

By changing values in the Inspector, you make changes to your Parts and Tracks. 
For MIDI Parts and Tracks, some fields are duplicates of settings in the MIDI 
Mixer, while others can be found only in the Inspector. To get a basic concept of 
how to use the Inspector, follow the steps below:

1. Open the Inspector.

2. Select a MIDI Track on which you have recorded some music.
This example describes how to use the Inspector with a MIDI Track; the proce-
dures for Audio Tracks are similar.

3. Check that no Parts are selected.
The heading of the Inspector should read “Trackinfo” - otherwise, just click on 
an empty area in the Part Display.

4. Start playback.

5. While the music is playing, try changing the "Transpose" and "Volume" 
values in the Inspector.
The transposition and volume of the played back music will change accord-
ingly.
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Making Real-time changes with the Inspector

When you change the value of a parameter in the Inspector, the new value is immedi-
ately sent out to the MIDI Output. This will affect not only the sound source assigned 
to the selected Track, but all MIDI devices connected to the same Output as the 
Track, and set to receive on the same MIDI Channel.

You may use this feature for setting appropriate values (e.g. volume, velocity etc.) 
while the music is playing.
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What is affected by the Inspector?
This depends on what is selected in the Arrange window. The following possibilities 
exist:

When a Track, but not a Part, is selected:

When no Parts are selected, the Inspector has the heading “Trackinfo”. The parameter 
values affect the selected Track, and all the recorded material (the Parts) on it.

● For Audio Tracks, you cannot change the settings for a complete Track, only 
for individual Parts.

The Inspector opened for 
the Track “Piano”.
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When One MIDI or Audio Part is selected:

The Inspector has the heading "Partinfo". The parameter values affect the selected 
Part only.

When Two or more MIDI Parts are selected

The Inspector has the heading "Partinfo", and shows the parameter values of one of 
the selected Parts. If you change a parameter, a dialog box will appear, asking if 
you want to apply the changed value to all selected Parts.

When Two or more Audio Parts are selected

The Inspector will have the heading “Partinfo”, and you will be able to make set-
tings as usual, but any changes you make in the Inspector will only affect the first of 
the selected Parts. In effect, you can only make settings for one Audio Part at a time.

The Inspector opened for 
the Part ”Pi Solo”.
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How MIDI Part and Track settings relate

As you have seen, you may change parameter values both for the whole MIDI 
Track and for individual Parts on the Track. It is the latest change that “counts”. If 
for example you change the velocity value of a single Part and then set another 
velocity value for the whole Track, the Part will also get this latest velocity value. 
Other parameter settings for the Part will remain unaffected.
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● This applies to MIDI Parts and Tracks only, not to Audio Parts. You can only 
make Inspector playback settings for one Audio Part at a time.

Make various settings for a Part...

...then change the velocity value 
for the whole Track.

Now the velocity value for the Part is 
changed to that of the Track, but the other 
settings for the Part remain unaffected.
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The Fields and Values in the Inspector
The Inspector contains names, numerical values and pop-up menus. All these settings 
can be changed using any combination of mouse and keyboard, as usual. Like all 
other changes, these can of course be done while the music is playing and even while 
recording.

Audio Parts

Parameter Explanation

Track/Part 
Name

The name of the selected Track/Part.

Record Info If you double click on this box, a dialog will appear, where you can 
change the folder in which created audio files are stored.

Mono/Stereo Use this button to determine whether the Audio Track should be in 
Mono or Stereo before you start recording, as described on page 35. 
Once you have recorded, imported or dragged any audio onto the 
Track, you cannot change this setting.

Volume A volume value for the Part (0 - 127). If this is set to “OFF”, the Part 
will play back at full volume.
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MIDI Parts/Tracks

Fade In The Fade In time. The higher value, the longer time it will take for 
the sound to reach its full volume, starting from the beginning of the 
Part.
If you want the Audio Part to play back normally from the start, with-
out Fade In, set this parameter to “OFF”.

Fade Out The Fade Out time. If you set this to any other value than “OFF”, the 
volume will decrease at the end of the Part , causing the sound to 
fade away. The higher value, the earlier in the Part the fade out will 
begin.

Parameter Explanation

Track/Part 
Name

The name of the selected Track or Part.

Output The serial port (Modem or Printer) used for MIDI Output. You cannot 
change the value in this field (it serves as a reminder only). To switch 
Output port globally, you have to use the MIDI Interface dialog, 
reached from the Options menu.

Chn The MIDI Channel associated with the Track. You cannot change this 
value.

Parameter Explanation
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Bank Lets you associate a MIDI Bank Select message with a Track or a Part, 
to make a connected instrument switch "program bank".

Prg Lets you associate a MIDI Program Change message with a Track or a 
Part, to make a connected instrument switch from one sound to an-
other.

GM Name The General MIDI instrument name associated with the Program 
Change number in the Prg field above. Click in this field to open a 
pop-up menu, where you can select a GM instrument without having 
to use Program Change numbers.

Volume A volume value for a Track or a Part. This setting is sent out as a MIDI 
Volume message.

Transp Lets you transpose the notes in a Part or a Track.

Veloc The value in this field is added to the velocity of the notes played 
back.

Pan Sends out a MIDI message, telling your instrument to place the sound 
of the Part/Track in a certain position in the stereo field.

Parameter Explanation
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Real-time Thru
In most MIDI recording situations, the Thru function in Cubasis AV is used to 
“echo” incoming MIDI data via MIDI Out. If you use the Thru function, the MIDI 
data that Cubasis AV receives via MIDI In is modified in real-time by some of the 
Playback parameters. This means that if you for instance set a transposition value 
of 7 (semitones) and play your keyboard, all notes coming out via the MIDI Out are 
transposed a perfect fifth higher.

Notes from the keyboard...

...are passed through 
the Inspector...

...and output again, 
transposed a fifth higher.
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This allows you to try out what effect a certain parameter setting will have on the 
music, before and when you record something. Since different Parts can have differ-
ent settings you must select the right Track and check that the Song Position is 
somewhere within the Part that has the settings you want to try. 

● It doesn’t matter which Part or Track you have visible in Part Info (you may have 
stepped through the Parts and Tracks with the arrow keys on the computer key-
board), it is only the Song Position and Active Track which determines which 
Part’s settings should be used for the real-time modification. 

The real-time parameters used for modification are Transpose and Velocity.

The settings for the Part in 
the "cross" made up by the 
Active Track and the Song 
Position is used for real-time 
"Thruing".
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How Functions are applied

● The procedures in this chapter are relevant for MIDI Tracks only.

By using the items on the Functions menu you can perform various operations on 
notes and other MIDI data. The most important of these functions is called Quantiza-
tion, and will be explained in detail in this chapter. However, before explaining how 
the functions work, it is important to know exactly what is affected by a function:

• Functions will apply to all selected Parts. 
If there are no selected Parts, the function will apply to all Parts on the active 
Track.
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Quantizing

What is Quantizing?

Quantizing is a function that automatically moves recorded notes, positioning them 
on exact note values. If you record a series of eighth notes, for example, some of 
them may end up slightly “off” the exact eighth note positions. Quantizing the 
notes with the Quantize value set to eighth notes, will move the “misplaced” notes 
to exact positions.

The Quantize value concept may need some explanation. By setting this value, on 
the pop-up menu on the Status Bar, you select the exact positions the notes should 
be moved to when you quantize. These are the options:

This column is for selecting the basic 
Quantize note value. As you see, the 
available values range from 1 (whole note) 
to 64 (1/64 note).

If you select OFF, no quantizing 
will be done.

If you drag the pointer to the right, you 
can add a “T” or a “.” option to the note 
value. This will result in a triplet (T) or 
dotted (.) Quantize value.

In this example a Quantize value of 
eighth note triplets is selected.
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Selecting Over Quantize

In Cubasis AV, the Quantize function is called “Over Quantize”. This is a very 
musical version of the standard “auto correct” quantize, that will move notes to the 
closest quantize value, without changing the length of the notes.

To Quantize your music, proceed as follows:

1. Select the Part(s) that you want to Quantize.
If you have no Parts selected, all Parts on the selected Track will be affected.

2. Pull down the Functions menu and select Over Quantize or press [Q] on 
the computer keyboard.
The notes in the selected Part(s) are quantized according to the selected 
Quantize Value.

● Quantizing can also be performed from within a MIDI Editor, allowing you to 
quantize any selection of notes and other Events. How to select which Events 
are to be quantized is described on page 223.
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Undoing Quantize

● Quantizing in Cubasis AV is not done “once and forever”! You can always 
re-quantize to any value, even to Off, and even after saving to disk. 

This means that notes quantized to eighths can later be quantized to sixteenths. The 
original (un-quantized) positions of the notes are used for determining how notes 
should be moved.

To completely restore quantized notes to their original positions, use the Undo 
Quantize function on the Functions menu. This can be applied to any selection of 
Parts, just as all Functions (see page 161).
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Other Functions
The Functions menu is not only used for quantizing, it contains a couple of other 
functions as well. The same rules as for Quantizing are used to decide what gets 
affected. 

Delete Doubles

This command erases all double notes, which may occur when you record with Cycle 
activated. Double notes could be hard to hear, but sometimes they sound like short 
delays or flanger effects (or even just as one extra loud note).

Notes are considered to be doubled when they have the same note number (pitch) 
and have identical start points.

Delete Cont. Data

This command erases all continuous data such as Modulation, Pitch Bend, etc. 
Notes and Program Change Events are left unaffected.
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Introduction
Just as you use the Finder to manage your files and folders, you use the Pool to 
manage your audio segments and files.

Opening the Pool Window
The Pool is opened by clicking the “Pool” button on the Transport bar.
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Overview of the Window

The Pool lists all the audio files in the Song. Please note that this means it shows the 
files for all Arrangements that belong to the Song.

Segment names

Audition button

File names Segment waveform imagesHeadings
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About Files and Segments

Files

Each time you record audio, an audio file is created on your hard disk. Each file 
currently used in the Song is shown in bold text in the Pool.

Segments

You don’t need to use the whole file in your arrangement. You might instead want to 
specify that only a portion of the file is to be used. To do this you specify a Segment 
of the file.

When you record audio, a Segment with the full length of the audio file is automat-
ically created, and it is this that is played back from the Arrangement.

Later in this chapter you will learn more about creating your own Segments, which 
play any part of the file.
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Customizing the Display

Showing and Hiding Segments

For one File

• To display/hide the segments belonging to one file, click on the triangle 
preceding the file.

For all Files

• To Show all segments for all files, select Expand from the pop-up View 
menu.

• To Hide all segments for all files, select Collapse from the same menu.

• To toggle between showing and hiding all segments for all files, hold 
down [Option] and click on one of the triangles preceding the files.

Hiding Headings

If you don’t need the Headings at the top of the window you can hide them using 
the “Hide/Show Headings” item on the pop-up View menu.
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Selecting what is shown

If you don’t need all the information fields for the files and segments, you can deacti-
vate these by clicking the “i” icon at the top of the window. Among other things this 
allows you to get a more detailed overview of the waveforms.

Zooming and setting Sizes of the Waveforms

If you change the width of the window, the waveforms are scaled accordingly. That 
is, the bigger you make the window the more detailed view of the waveform you 
will have.

By clicking the Magnification Glasses you can set the vertical size of the lines, to 
get a better overview of the waveforms.

Selecting Time Formats

You can set unit of measure for the Start, End and Length values, by clicking the 
Time Format button at the top of the window. Each time you click, the symbol in 
the button changes, and a new format is selected.

The Time format button indicates which format is currently selected.

Sample format Time code format (“frames”) Meter position format
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• If you select samples, the values are shown as numbers of samples. 
Since Cubasis AV uses 44.1 kHz sample rate, there are 44100 samples per 
second.

• If you select time code format, the values are shown in the format 
“hours:minutes:seconds:frames”. 

• If you select meter position format, the start and end inset values indicate 
the start and end position of the first instance of the segment in the Song, 
as bars, beats and ticks.
If the segment is not used, the start inset will show 1.1.0 and the end inset will 
show the end position as it would be if the segment had really started on 
1.1.0. 
The length value shows the length of the segment in bars, beats and ticks, 
starting with 0.0.0 - in other words the difference between the end inset value 
and the start inset value.

● Please remember that if you have meter position format selected, the End Inset 
and Length values are tempo dependent. That is, if you change the tempo, 
these values will change as well.
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Setting File and Segment Order

File Order

On the View menu, you can determine in which order the files should be displayed:

Segment Order

By selecting “Order Segments” from the pop-up View menu, you rearrange the seg-
ments so that they are shown in the order they appear in the file.

Option Description

By Name Files are shown alphabetically.

By Date Files are shown ordered according to the time they were created, with 
the newest file on top.

By Size Files are shown in size order, with the largest one on top.
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The Headings and Columns
For each file/segment you have a number of information and setting fields. The 
names for these are displayed in two rows of headings at the top of the window.

The file headings and their corresponding fields in the Pool window.

The segment headings and their corresponding fields.
- 174 - 



Below follows a brief description of each entry in the headers. Many of these are 
used in various operations described later in this chapter.

File Heading Explanation

File Name The name of the file, on disk.

Disk The Disk the file resides on.

S/M Indicates if the file is mono (one bullet) or stereo (two bullets). 

F A tick mark indicates the file has been found, a crossed circle shows 
that it has not been found (see below).

Length This shows the size of the file in kilobytes.

Date and 
Time

This shows the date and time the file was created.
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Segment HeadingExplanation

Hear To play the segment, click in this column (on the speaker symbol) 
and hold down the mouse button.

Segment (name) The name of the segment.

Start The segment’s Start Inset in the file. Displayed in samples, as a 
meter position, or as time code, depending on the selected format 
(as described on page 171 in this chapter). This can be changed, 
see below.

End The segment’s End Inset in the file. Can be changed.

Length The length of the segment. Can not be changed.

SRate The Sample Rate of the file.

Range An overview of the segment in the file. You can use this to graphi-
cally fine-tune the start and end points of the segment.
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Finding Out how a Segment is used in the Song
One segment can be used in more than one place in a Song. There are a number of 
situations where you will want to find out where a segment is used, for example:

• So that you can tell that a segment isn’t used anywhere and possibly delete it.
• If you want to know if a segment is used in more than one place, so that you 

can decide how editing the segment affects the Song.

Number of Times the Segment is used

Next to the speaker icon for each segment, you will see a number telling how many 
times in the Song this segment is used. A segment without numbers is not used any-
where.
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File Operations

Renaming a File

To rename a file, proceed as follows:

1. Double click on the existing name.

2. Enter a new name or edit the existing one.

3. Click outside the box or press [Return].

● Renaming a file this way is much preferred to renaming it from the Finder. 
This way, Cubasis AV “knows” about the change and will not lose track of the 
file the next time you open the Song. See page 181 for details about lost files.
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Locating a File on the Hard Disk

To find out where on the hard disk a certain file is located, hold down [Command] 
and [Option] and click on the file. A pop-up showing you the file location appears.

Deleting Files

Removing from Pool

If you want to remove one or more files from the Pool without actually deleting 
them from the hard disk, proceed as follows:

1. Select the file(s).
Selecting more than one is done just as with any other object in Cubasis AV, 
by clicking in combination with the [Shift] key.

2. Press [Backspace].
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• If you try to delete a file that is used by one or more Parts, the program 
will ask you if you also want to delete those Parts.
Cancelling this operation means that neither the file nor the Parts are deleted.

Removing from the Pool and deleting from Hard Disk

If you want to remove the file from the Pool and also delete the file permanently 
from the hard disk, proceed as follows:

1. Select the files.

2. Hold down [Command] and press [Backspace].
A dialog box asks you if you are sure you want to continue. Remember that 
this operation cannot be undone!

Creating a Segment

You can create a “default” segment for the file, that is one that plays the entire file.

1. Select the file.

2. Select Duplicate Segment from the Do pop-up menu or press [Option]-[D].
The new segment can be edited to play any part of the file (see page 187).
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Handling “Missing Files”
When you open a Song, you may get a warning that one or more files are “missing”. 
If you click Ignore, the Song will open anyway, without the missing files. In the Pool 
you can check which files are considered missing. This is indicated by a crossed 
circle next to the file (instead of the usual checkmark).

A file is considered missing under one of the following conditions:

• The file has been moved to another folder or renamed in the Finder since the 
last time you changed the Song 
and 
you ignored the Missing files dialog when you opened the Song.

• You have used the Finder to move, rename or change properties such as date 
for the file since you started the program this time.

File is missing

File is found
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Locating a missing file

1. Click on the crossed Circle.

2. In the dialog that appears, decide if you want the program to try the find 
the file for you (Auto) or if you want to do it yourself (Manual).

Auto

If you choose Auto, the program scans all your hard disks for a file with the proper 
name and creation date.

If Auto doesn’t work

Please note that Cubasis AV is quite strict about identifying the files you use. 
Cubasis AV retains information on the Name and Creation Date of every file saved 
in a Song. If these values are changed by you, or a program you may be using, you 
will not be able to rely on Cubasis AV's “auto-find” function. In this case you will 
have to use the “Manual” option and “over-ride” the subsequent warnings.

Manual

If you choose Manual, the program will display a file dialog allowing you to locate 
the file manually.
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When you have found the file, click OK to replace the missing file in the Pool. If the 
name or date is not identical to the missing one, the program will warn you but let 
you proceed. The next time during this session that the program attempts to search 
for a missing file, it will first look at the position of the last found file.
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Segment Operations
The Pool allows you to create new segments, slightly or drastically different from 
those you already have in your Song, and drag and drop these in the Arrange window.

Auditioning a Segment

From the Beginning

To audition a segment from its beginning, press and hold the mouse button with the 
pointer over the speaker icon to the left of the segment name.

When you press and hold the mouse button, the pointer turns into a loudspeaker symbol.
- 184 - 



From any Position

To start playback from any position in the segment, click with the mouse pointer in 
the waveform to the right. Playback will start from the position you click on.

When you press the mouse button, the pointer turns into a loudspeaker symbol.

Renaming a Segment

To rename a segment, proceed as follows:

1. Double click on the existing name.

2. Enter a new name or edit the existing one.

3. Click outside the box or press [Return].
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Duplicating Segments

To create a copy of a segment, proceed as follows:

1. Select the segment by clicking on it.

2. Select Duplicate Segment from the Do pop-up menu or press [Option]-[D].
The new segment appears in the Pool.

Deleting segments

● Deleting a segment never destroys any actual audio data.

Deleting one or several segments from the Pool

1. Select the segment(s).
Selecting more than one segment is done just as with any other object in 
Cubasis AV, by clicking in combination with the [Shift] key.

2. Press [Backspace].

• If you try to delete a segment that is used by one or more Parts, the pro-
gram will ask you if you also want to delete those Parts.
Cancelling this operation means that neither the segments nor the Parts are 
deleted.
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You can tell how many times a segment is used in a Song by checking the number 
next to the speaker icon.

Deleting all Segments not used in the Song (Purge)

To automatically delete all segments that are currently not used in the Song, select 
Purge Segments from the Do pop-up menu. This is a quick way to “clean up” the 
Pool, making it easier to get a good overview.

Changing Start and End Insets

You can change the Start and End points of the segment. This allows you to change 
what part of the audio file the segment plays. One use for this is to remove unwanted 
silence at the beginning or end of a recording.

● Please note that this change will affect all places in the song where this segment 
is used. If this is not what you want, make a duplicate of the segment first, and 
make the changes to this. Then drag the changed segment into the Arrange 
window and place it wherever you want it.

Changing the Start and End Inset can be done in two ways.
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By Numerical Editing

When the insets are shown in the Sample format (see page 171), you can adjust the 
Start and End Inset values by regular value editing. The waveform to the right will 
adjust to show your changes.

By Dragging

You can also drag the Start and End Inset directly in the waveform.

1. Position the pointer over the beginning or end of the segment.
If the segment currently plays the entire file, these two points are at the begin-
ning and end of the waveform image.

2. Press the mouse button and drag left or right.

When you edit the segment graphically this way, it may be a good idea to turn off the 
Information, by clicking the “I” button, and zoom in on the waveforms by clicking 
on the “+” Magnifying glass. That way, you will get a larger waveform display.
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Moving the Segment

To move the segment within the file, without changing its length, proceed as follows:

1. Hold down [Command].

2. Position the pointer over the segment and drag left or right.
A dotted outline of the segment is shown while you are dragging.
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Importing Audio Files into the Pool
From the Pool you can import files created by other programs, or files you have 
created in another Cubasis AV Song.

File Formats

Files in the following formats can be imported:

• Sound Designer II or Audio IFF (AIFF).
• Mono or Stereo.
• 44.1 kHz sample rate.

A regular Macintosh file dialog is used to select audio files to import.

After you have opened the first file, the dialog appears again allowing you to import 
more files. When you are done and don’t wish to import any more files, click Cancel.
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Exporting Files and Segments
You can export segments from the Pool as individual files, for use in other 
applications:

1. Select the segment you wish to export.

2. Select “Export Segments” from the Do pop-up menu.
A file dialog appears.

3. Use the file dialog to find a location and name for the file.

4. Click Save.

File Formats

Files you export from Cubasis AV are in AIFF format with 16 bit resolution and 
44.1 kHz sample rate.
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Dragging Segments into the Arrange Window
To move segments into the Arrangement, Cubasis AV uses drag and drop techniques:

1. Arrange the windows so that as much as possible of the Part Display in 
the Arrange window is visible, when you have the Pool window active.

2. Position the mouse button over the name of the segment and press the 
mouse button.

A dotted rectangle appears around the name of the segment.
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3. Drag the segment out of the Pool window and release it on an Audio 
Track in the Arrange window.
The Snap value applies as usual.

A new Part is then created, playing the segment you dragged.
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Saving and Loading the Pool
The Pool is automatically saved with the Song. However, by using the Load and 
Save Pool commands on the pop-up File menu, you can freely save Pools and load 
them into Songs. 

Saving

1. Select Save Pool from the File Pop-up menu.

2. In the dialog box that appears, specify if you want to save all files and 
segments, or just the selected ones. 

3. In the standard dialog box that appears, specify a name and a location 
for the file.

A Pool document as it looks in the Finder.
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● The audio files themselves are not saved in the Pool file, only a reference to 
them. You should probably not move any audio file(s) until next time you 
want to use the Pool. You should definitely not delete them!

Loading

A Pool file is opened (loaded) just like any other file. When you load a Pool file, the 
files in it are added to the current Pool.
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Importing Audio
You can import audio into the Song, from the Arrangement or from the Pool. Use 
the former when you want to position the file on a Track directly, and the latter 
when you plan to edit the file before using it in an Arrangement.

File Specifications

The files that you import must meet the following specifications:

• The file must be in AIFF (Audio Interchange File Format) or SD2 (Sound De-
signer 2) format.

• It can be in Mono or Stereo.
• The sample rate must be 44.1kHz.
• The file must have 16 bit resolution.

Naturally, the files created by Cubasis AV fit into these specifications.

Importing into the Arrangement

The Import Audio item on the File menu imports a file into the Arrangement as 
follows:

1. Select the Track where you want the audio file to appear.

2. Set the Left Locator at the point where you want the file to start.
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3. Select Import Audio File from the File menu.
A file dialog appears.

4. Locate the file, select it and click OK.
The following now happens:

• The audio file is added to the Pool.
• A segment is created, that plays the entire audio file.
• A Part, playing the segment, is created and positioned on the selected Audio 

Track, starting at the Left Locator position.

Into the Pool

This is described on page 190.
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Exporting Audio

Exporting from the Arrangement

It might happen that you want to turn the whole or parts of an Arrangement into a 
single audio file. There are mainly three reasons for doing this:

• You are running out of audio Tracks and decide to “merge” for example a 
number of vocal overdubs into one recording, instead of keeping each overdub 
on a separate Track.

• You have set up some processing (volume changes, treble and bass settings, 
effects etc) that you want to make a permanent part of a new file.

• You want to export the Arrangement for use in another program or for use in 
for example a QuickTime movie (see the chapter “Movies”).

Performing the Audio Mixdown

1. Set up the Tracks to play as intended. 
This includes making settings in the Inspector and in the Audio Mixer window. 

Please note the following:

• Muted Tracks will not be included in the Mix.
• Monitored audio channels will not be included in the Mix.
• Make sure the levels are set correctly so that no clipping occurs and that the 

overall volume is not too low. Use the Audio Mixer to check the levels.
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• The volume and fade set up for individual Parts in the Inspector will be used 
for the Mix.

• All settings in the Audio Mixer will be used for the Mix.

2. Set up the Left and Right Locator as desired.
Only the section between the Left and Right Locator will be included in the 
new audio file.

3. Select Export Audio File from the File menu.
A dialog box asks you for a new file name.

When the processing is done, a new file is created on the hard disk. This can then (if 
desired) be re-imported into the Pool or an Arrangement.

File Specifications

The files created when exporting have the following specifications:

• AIFF (Audio Interchange File Format).
• Stereo.
• 44.1kHz sample rate.
• 16 bit resolution.

Tips and Tricks

Audio mixdown can be used practically and creatively. Below follow a few tips:
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• Set up a fade between two recordings and do a Mix of the two into a new 
audio file.

• Set up a fade or other effect on one audio file only. Mix it down to a new 
file to make the change permanent.

• Add bass/treble changes or effects to a sound, solo it and mix the proc-
essed sound down to a new file. Then play back this processed recording 
instead of the original, and deactivate the bass/treble/effects that were 
previously used. This will allow you to add more bass, treble or effects to 
the same recording!

Exporting from the Pool

This is described on page 191.
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What can I do with the MIDI Editors?
When you record MIDI data, you fill Parts with notes and other MIDI “Events”. 
But you don’t really get to see and manipulate those Events individually from the 
Arrange window. In the MIDI editors you do!

Different types of Events and where to find them
On the following pages we’ll list the different types of MIDI data that Cubasis AV 
can record, and how and where they are displayed for editing.
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Notes (Note On and Off messages)

Notes are displayed in all MIDI editors. Let’s look at a simple melody line and how 
it is shown in the different editors:

In Key Edit

The notes are shown as boxes, with higher notes higher up in the grid. 
The note length is indicated by the width of the rectangle.

The piano keyboard to the left is there to make it easy to find the 
right pitch when inputting or editing notes.
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In List Edit

The notes are shown both in the list to the left, 
and in the graphic display to the right.

The black bar graphs are for graphically displaying and editing MIDI “Value 2” 
in every Event. In the case of notes, “Value 2” is the velocity value.
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In Score Edit

In Score Edit, notes are displayed and edited just as notes in a printed score.
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Continuous Events

In MIDI, various types of MIDI messages are used to transfer continuous changes. 
To be exact, these types are:

• Aftertouch (Channel Pressure).
• Pitch Bend.
• Controllers, like sustain pedal, MIDI Volume, Modulation wheel etc.

To be really exact (not to say pedantic!) some of these are not really continuous. 
Sustain Pedal for example can only be down (On) or up (Off). However, the MIDI 
specification groups all these messages as Continuous messages, and so does 
Cubasis AV.
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Continuous messages are shown and edited in Key Edit and List Edit:

The “mountains” of continuous data in the Key Edit window above are in 
reality a large number of single Events. This becomes clear when looking at 
the same data in the List Edit Window on the next page:

In Key Edit, the area beneath the Divider is the Controller Display.

Clicking on this icon brings up a pop-up menu, allowing you to select which type of 
continuous data should be shown. In this case, modulation wheel Events are displayed.
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● Please note that only the most common Continuous Controller Events are 
shown in Key Edit. These are Aftertouch (Channel Pressure), Pitch Bend, 
Modulation, Main Volume, Pan and Velocity. To display, create or edit other 
types of Continuous Events, use List Edit.

The modulation Events are 
listed in their playback order.

Value 2 for each Event is shown in the list and in the bar 
display. The grey color indicates non-note Events.
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Program Change messages

A Program Change message is a MIDI Event, telling a connected MIDI device to 
switch to another Program (e.g. a sound in a synthesizer, a setting in a reverb device, 
etc.). You can record Program Change messages into Cubasis AV like any other 
Event. If you want to edit (or create new) Program Change messages, it can be done 
in List Edit. See the the chapter “List Edit”.

System Exclusive messages

System Exclusive messages are a special kind of MIDI Event, intended for detailed 
control of the parameters of a MIDI device. Since all devices have different parame-
ters, each major manufacturer of MIDI devices has a special ID code that is included 
in the System Exclusive message.

Cubasis AV can record and play back System Exclusive messages, but they can not 
be edited or created from scratch.
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Opening An Editor

By double clicking on one Part

Which editor opens depends the “Double Click Opens” setting:

1. Pull down the Options menu and position the pointer on the Double 
Click Opens item.
A submenu appears.

If you only want to open one Part into an 
editor, simply double click on it.
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2. Select one of the three items on the submenu.
You can choose between Key, Score and List Edit.

3. Save your Song.

If you want this setting to be valid for all new Songs, you should set up your 
“Autoload” song for this. See page 334.

Editing a complete Track

You can edit all Parts on a Track at the same time:

1. Make sure no Parts are selected, by clicking somewhere 
in an empty area of the Arrange Window.

2. Select the Track you want to Edit.

3. Select the preferred editor from the Edit menu 
or use the keyboard equivalents.
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Editing more than one Part

You can edit any selection of Parts, even Parts on different Tracks at the same time. 
The only restriction is this:

● List Edit can only be used to edit Parts that are all on the same Track.

1. Select the Parts you want to Edit.

2. Select the preferred editor from the Edit menu or use the keyboard 
equivalents.
The editor opens, showing the selected Parts at the same time. However, only 
one at a time is active. The active and inactive Parts are separated graphically:

● In Key Edit, notes belonging to an active Part are brightly colored or white 
(dark or black when they are selected, see below) and notes belonging to an 
inactive Part are dimmed (and grey when selected). In Score Edit, different 
Parts are put on different note systems.
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3. To activate a Part within an editor, click on any Event belonging to that Part.
You can also use the Next/Previous Part commands on the Goto pop-up 
menu, which is convenient if the Part is empty.

If you haven’t recorded any Part yet

You might want to open the editor to input notes from scratch, without recording 
anything first. In this case you have to create a Part, using any of the methods 
described on page 112.

Active and Inactive
Parts in Key Edit
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About Recording and Playback
Basically, anything you can do in the Arrange window that relates to playback and 
recording, can also be done in the editors.

Realtime

Like everything else in Cubasis AV, editing can happen in realtime. This means that 
you can edit while the music is playing or actually even while you are recording!

Step Recording

If you prefer not to record your music in real time, you may use the Step Recording 
function to input music one note at a time. This is explained in the chapter “Step 
Recording”.
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Follow Song

If Follow Song on the Options menu is turned on, the Edit window will scroll auto-
matically during playback, so that the current Song Position is always visible.

• You may also press [F] on the computer keyboard to turn Follow Song on 
and off.
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Ed Solo

When this button is activated, you will only hear the Track/Parts that are currently 
being edited. All other Tracks are muted. Use this function when you want to con-
centrate on editing the Parts in the editor, rather than hearing the music in its con-
text.

Cycle

If the Cycle button on the Transport Bar is activated, a certain section of your arrange-
ment will be repeated over and over as described in the chapter “Cycled Playback and 
Recording”. This is very handy for editing where you can fine-tune a recording and 
instantly hear the result without having to Rewind and Play to get to the right section.
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The Loop Function

In all of the MIDI editors you can set up a local Loop, which is a sort of "mini-cycle" 
for the Parts being edited. The Loop facility operates in addition to the Cycle, mean-
ing you can Loop the Parts you are editing while Cycling Parts that are not being 
edited!

There are three ways to set the Loop:

• Drag the mouse on the Position Bar to draw the Loop area. 

This does not work in Score Edit, since it has no Position Bar.

• Use the mouse and/or computer keyboard to set the values in the Loop 
boundary boxes on the Status Bar. 

• Use [Option]-[L] and [Option]-[R] to open the Loop boundary boxes and 
enter the values.

Either way, the current Loop is shown in black on the Position Bar when it is on, 
and in grey when it is off.

The upper value is the start of the Loop, the lower is the end.

The Loop On/Off button
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Turning the Loop on or off

Turn the Loop on/off by clicking on its button or by pressing [Option]-[O]. For this 
to work, you have to define the Loop first, as explained above.

When the Loop is active, the Parts within the Loop in the Edit window loop almost 
independently of the rest of the music. We say "almost", because the Loop is still 
dependent on the Cycle. Every time the Cycle starts over again, so does the Loop.

The Loop is also used to direct editing to the Events inside the Loop. See page 225 
in this chapter.

Playback Parameters

The Playback settings you may have done in the Inspector are not visible when you 
edit the Part. This means that if a Part is transposed using the Inspector, it will be 
shown at its original recorded pitch in the editor, even though you will hear it playing 
back transposed. 
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Moving around and the Goto pop-up menu
You can move directly to certain useful positions in an editor by selecting from the 
Goto menu on the Function Bar. These options will scroll your view to show the 
Events at the chosen position.

● The Goto commands don't affect selection in any way. They only change the 
view as if the scroll bars were used.

Song Position Takes you to the Song Position.

First Event Takes you to the first Event in the active Part.

Last Event Takes you to the last Event in the active Part.

First Selected Takes you to the earliest of all the selected Events.

Next Selected Takes you to the next selected Event.

Last Selected Takes you to the last of the selected Events.

Prev Selected Takes you to the selected Event before the one 
currently in view.

Next Part Takes you to the beginning of the next Part. 
This might just lead to a vertical scroll if there are 
several Parts beginning at the same Position.

Prev Part Takes you to the beginning of the previous Part. 
This might just lead to a vertical scroll (see above).
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Creating Events in the Editors
This is mainly done with various tools from the Toolboxes:

• The Pencil tool is used to “draw” notes and other Events in Key and List 
Edit (see page 238 and page 265).

• The Paint Brush tool is used to “paint” series of notes in Key and List Edit 
(see page 240 and page 265).

• The Note and Rest tools are used in Score Edit, to create notes and rests 
respectively (see page 282).

Creating notes with the Fill function

All the editors have a pop-up menu named “Do”. The contents of this pop-up menu 
varies with the different editors, but all include a function called “Fill”.

This function only works when the To menu is set to "All Events", "Looped 
Events" or "Cycled Events" (see page 225). It then fills the whole Part/the Loop/the 
Cycle with notes that have the same pitch. The notes are spaced according to the 
Snap value and are all given a length corresponding to the Quantize value.
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Monitoring Events in the Editors
As already mentioned, you can have playback running while you are editing. And, 
you can also use the cue function (see page 84) in the Edit windows. But there are 
two more ways to listen to your music in the editors:

The Magnifying Glass

The Magnifying Glass tool is common to all MIDI editors. When you click on an 
Event using this tool, the Event is played back. You can also hold the mouse button 
and drag the Magnifying Glass around over the Events.

The Speaker

When you click on the speaker symbol on the Status Bar, Events will be output 
automatically when you click on them, when you create them using the pencil or 
paint brush, and when you make changes on the info line.
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Selecting Events in the Editors
Selecting Events in the editors is done just like selecting Parts in the Arrange window, 
described on page 113. You can:

• Click on an Event to select it (and deselect all others).

• Hold [Shift] and click on an Event to select it, adding to any previous 
selection.

• Select several Events by enclosing them in a rectangle using the Arrow 
tool.

• Press [Command]-[A] to select all Events in the editor.
This is the same as using the Select All item on the Edit menu.

• Use the [←] and [→] keys to select the previous/next Event in the Active 
Part.
If you hold down [Shift] and use the arrow keys, the next/previous Event will 
be selected, without deselecting already selected Events.
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Selecting Events from different Parts

You can select Events from both an active and an inactive Part:

1. Select the Events you want in the active Part, using any method described 
above. 

2. Hold down [Shift].

3. Select one Event from an inactive Part by clicking on it. 
This Part now becomes active. 

4. While keeping [Shift] pressed, use any method to select more Events 
from the now active Part. 
As long as you keep [Shift] pressed, you can switch active Parts and select 
from as many as you like.

● Any type of editing you do (like moving, copying and so on) will affect all 
selected Events, whether they are in active or inactive Parts.
(Note, however, that the setting on the To pop-up menu may further restrict 
which Events are affected, see below.)

● When you record, use Step Input or make any other changes via MIDI, it is 
always the active Part that is affected.
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The To Pop-up

All the editors have a pop-up menu called “To”. This is used together with the Loop 
and Cycle functions to collectively choose a group of Events to be affected by your 
editing.

All Events, active or inactive, will be affected.

All Events inside the Loop 
will be affected, regardless 
of whether the Loop is On 
or Off, or whether the 
Events come from active or 
inactive Parts.

All Events inside the Cycle will 
be affected, regardless of 
whether the Cycle is On or Off, 
or whether the Events come 
from active or inactive Parts.

All selected Events, inactive or 
active, will be affected.

Those Events that are inside 
the Loop and selected will 
be affected.

Those Events that are inside the Cycle 
and selected will be affected.
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About Editing
This is done differently in every editor, using the various tools in the Toolboxes. 
Refer to each editor’s chapter for detailed information about how to use the different 
tools.

Quantize and Snap Values in the Editors

The Quantize and Snap values work exactly as in the Arrange Window 
(see page 120). However, there are a couple of things worth pointing out:

• Each editor has separate settings for Quantize and Snap values.
This means that the settings you make in the Key Edit window will not auto-
matically be transferred to Score Edit. This is practical, due to the different 
work methods you will employ in the different editors.

• The Quantize value also determines the length of input notes.
If for example you have the Quantize value set to 8, the notes you create will 
automatically become 1/8-notes.

• The Snap value also defines the spacing between input notes.
This applies when you use the paint brush or the Fill command from the Do 
pop-up. With a Snap value of 4 and a Quantize value of 16, you will get six-
teenth notes, positioned on the beats (quarter-note positions).
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• The Snap pop-ups in the editors contain more options than the one in the 
Arrange Window.
This is because, unlike when moving Parts, you may need small or uneven 
Snap values in the editors. The following Snap values are available:

Editing Notes via MIDI

You can change the properties of notes via MIDI. This can be a handy and fast way 
to get for example the right velocity value, since you will hear the result even as 
you edit:

1. Select the note you want to edit.

2. Click on the MIDI Connector symbol on the Status Bar.

The symbol should be “lit”. This enables editing via MIDI.

The values 2 - 7 are 
values in ticks, 
allowing high 
precision editing 
and moving.

The values ranging 
from 64 to 1 are 
regular note values. 
Triplets (T) and dotted 
(.) note values can be 
selected.
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3. Use the Note buttons on the Status Bar to decide what properties will be 
changed by the MIDI input.
You can enable editing of Pitch, Note On- and/or Note Off-velocity.

With this setting, the edited notes will get the Pitch and Velo-off values of the notes inputted 
via MIDI, but the Velo-on values will be kept as they are.

4. Play a note on your MIDI instrument.
The note selected in the editor will take on the properties of the played note, 
according to the setting made in step 3.

The next note in the active Part automatically gets selected. A series of notes 
can therefore quickly be edited.

• If you want another try, select the note again (easiest by pressing the [←] 
key on the computer keyboard) and again play a note on your MIDI 
Instrument.
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The Info Line

At the top of the Key and Score editors, you have the Info Line.The Info Line 
shows the values for one selected note. The values can be edited, just as in the List 
in List Edit:

1. To show/hide the Info Line, click on the i-button on the Status Bar or 
press [Option]-[I] on the computer keyboard.

2. Select a single Event.
Its values are shown on the Info Line.

If no Event or several Events are selected, the Info Line shows "– – –" for all values.

3. Change the desired values using regular value editing.
As always, you can use the mouse or type in values from the computer key-
board.

When the “i” button is lit, the Info Line is shown.
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Info Line Parameters

The following parameters can be changed on the Info Line:

● Not all MIDI Instruments send and/or read velocity (especially true with Note 
Off velocity). Check your instrument’s operation manual if you are unsure.

Parameter Remark

Start Changing this value is the same as moving the note.

Length In ticks.

Pitch Changing this value transposes the note.

Velo-On The Note On velocity; the speed with which you press a key on a 
MIDI keyboard.

Velo-Off The Note Off velocity; the speed with which you release a key on a 
MIDI keyboard.

 Chan The “original” MIDI Channel associated with the note. In Cubasis AV, 
this value is of no relevance.
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Cutting, Copying and Pasting

You can use the Cut, Copy and Paste commands to move Events between editors or 
to duplicate a series of Events.

• Cut or Copied Events are Pasted in starting at the Song Position. The 
Events will keep their relative positions, pitch and other properties.

Deleting Events
To delete Events:

• Click with the Eraser tool on the Events you want to delete.

• Select the Event(s) you want to delete and press [Backspace].

or

• Select the Event(s) and select Delete from the Edit menu.
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Closing the Editor
There are two ways of closing the editor, “Cancelling” and “Keeping”.

Cancelling

If you press [Esc] (escape) on the computer keyboard, a dialog box allows you to 
change your mind:

Cancelling can be thought of as a super-undo. It allows you to try out a series of 
changes to a recorded piece of music and then easily revert back to its original state.

“Yes” will cancel all changes you have 
made since you opened the editor.

“No” will exit the editor, but 
keep your changes.
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Keeping

If you close the editor by clicking the window’s Close box or by pressing [Return], 
the window closes and all the editing you have done is kept.

The “Keep Appended Events?” Dialog

If you close the editor and a dialog appears asking you if you want to “Keep 
appended Events”, this is because you have added Events outside the Part(s) being 
edited.

• If you click “Yes”, the Part will be extended to encompass the added Events.
• If you click “No”, the Events outside the Part will be discarded.
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Which Editor should you use?
This of course depends on your individual way of working. However, the following 
suggestions may help you find your way:

Use Key Edit when...

• You want to get a quick overview of the Events.
• You want to edit several Parts at the same time.
• You’re editing Pitch Bend, Aftertouch, Main Volume, Modulation, Pan or 

Velocity values.

Use List Edit when...

• You need to perform detailed editing of single Events.
• You’re editing other kinds of Continuous Controllers than those available in 

Key Edit.

Use Score Edit when...

• You are used to reading and writing scores.
• You are preparing your music for printing.

● Key and Score Edit can be used to edit any combination of Parts from different 
Tracks. List Edit can only be used for Parts on one Track at a time.
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15

Key Edit 15
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Overview
Key Edit displays notes as boxes with higher notes higher up in the display, and the 
width of the boxes corresponding to the note lengths. The piano keyboard to the left 
is there to make it easy to find the right pitch when inputting or editing notes.

Key Edit also lets you display and edit Continuous Controllers (such as Pitch Bend, 
Modulation, Aftertouch, etc.) in a graphic Controller Display, as described on
page 249. 
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Below you will find a description of some of Key Edit’s main features:

The black notes are selected.

The position of the mouse pointer is 
shown both in the Mouse Box and on 
the Piano keyboard.

The Song Position Pointer

Clicking here opens the 
Controller Display.

The Snap and Quantize boxes.

The Goto pop-up is used 
for moving the view.

The Do and To pop-ups. 
See page 225.
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Entering Notes

Using the Pencil tool

1. Set the Snap value to the smallest position at which you want to enter a 
note.

2. Set the length of the note to be entered by changing the Quantize value.

For example, if you want to enter eighth notes at quarter note positions, set the Quantize 
value to “8” and Snap to “4”.

3. Select the Pencil tool from the Toolbox, and move the pointer onto the 
note display.
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4. Aim at the correct position.
The piano keyboard to the left and the two fields on the Status Bar will help 
you by showing the pitch and position.

5. Click once with the mouse.
The note appears.

The pitch of the note

The position of the note
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Using the Paint Brush tool

Use the Paint Brush to ‘paint’ in several new notes at a time:

1. Select the Paint Brush tool.

2. Position the pointer where you want the first note to be.

3. Press the mouse button and drag the pointer.
Notes are created according to the following rules:

• The notes are created at a spacing defined by the Snap value.
• The notes get the length of the Quantize value.
• If you hold down [Shift] on the computer keyboard, movement is restricted to 

a horizontal direction only when you are dragging (that is, all notes will have 
the same pitch). 
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The Insert Button

The Insert button

If the Insert button is activated on the Status Bar when you use the Pen or Brush, 
then all Events in the Part will be moved one Quantize value forward when you
input new Events, just as with Step Input (see the Step Recording chapter).

● You can also create new Events using the Fill function on the pop-up Do 
menu, see page 221.
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Setting the length while drawing

You can easily set note lengths to something else other than the quantize value, 
while entering them. The Snap value still applies so you can only set the Length to 
even multiples of this value.

1. Aim with the Pencil at the correct position and pitch.

2. Press the mouse button and drag to the right with the button pressed.

3. Release the mouse button. The Event is adjusted to the closest Snap 
value.
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Determining the note’s velocity

The Notes you enter have a fairly high velocity. In Key and List Edit you can change 
it by holding down modifier keys while clicking. Use the following modifier keys:

Velocity Modifier key

High (110) None

Medium - high (96) [Command]

Medium (64) [Option]

Low (48) [Command]+[Option]
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Manipulating Notes

Selecting Notes

This is done with the Arrow tool, just like selecting Parts in the Arrange window:

• Click on a note to select it.
• Hold down [Shift] and click to select several notes.
• “Draw” a rectangle around several notes to select them.

You may also use the left and right arrow keys on the computer keyboard to select 
the previous or next Event in the editor.

• If you select a single note, its values will be shown on the Info Line.
You can use the Info Line for detailed editing of single notes, as described on 
page 229.
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Moving Notes

1. Select the Arrow tool.

2. Set the Snap value.
If you want to be able to move the note(s) to even quarter note positions only, 
set Snap to 4. If you want to move them to even eighth note positions, set 
Snap to 8, etc. This works just like when moving Parts in the Arrange Window 
(see page 120).

3. Select the note(s) you want to move.

4. Position the pointer over one of the selected notes and press the mouse 
button.
The pointer takes on the shape of a hand.

• If you hold down [Shift], movement is restricted to either vertical or 
horizontal.
Use this if you only want to transpose the notes, or move them without trans-
posing.

5. Drag the note(s) to the new position and release the mouse button.
A dotted outline of the note(s) is shown while you drag.
- 245 - 



Duplicating Notes

1. Select the Arrow tool.

2. Set the Snap value as for moving notes (see the previous page).

3. Select the note(s) you want to duplicate.

4. Hold down [Option] on the computer keyboard.

5. Position the pointer over one of the selected notes and press the mouse 
button.
The pointer takes on the shape of a hand.

• If you hold down [Shift], movement is restricted to either vertical or 
horizontal.
Use this if you want move the duplicated notes in one direction only.

6. Drag the note(s) to the new position and release the mouse button.
A duplicate set of notes is created and positioned where you drag them.
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Resizing Notes with the Pencil tool

You can change the size of notes that you have drawn or recorded, using the Pencil 
tool:

1. Set the Snap value.
What you do when you resize a note, is to move the end position of that note. 
You can only resize in multiples of the set Snap value. That means, if Snap is 
set to 8, you can move the end-position of a note to 1/8, 1/4, 3/8, etc.

2. Press the mouse button with the Pencil pointer inside the note you want 
to resize.

● It might be hard to determine whether you have the pointer inside a note or 
not. To avoid painting in new Events, activate [Caps Lock]  on the computer 
keyboard. This disables creation of new Events. Remember to deactivate 
[Caps Lock] when you have finished resizing the notes.

3. Position the pointer at the length you want the note to have, and release 
the mouse button.
The note gets resized, taking the set Snap value into account.
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Deleting Notes

To delete notes:

• Select the Eraser tool and click on the notes you want to delete.

• Select the note(s) you want to delete and press [Backspace].

or 

• Select the note(s) you want to delete and select Delete from the Edit 
menu.
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The Controller Display
This is the area in Key Edit that is used for graphically displaying and editing Velocity 
and Continuous Controllers.

Opening the Controller Display

• Open the Controller Display by clicking on the Controller button below 
the piano keyboard to the left.
To close the Controller Display, click on the button again.
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Determining which Controller to display

The Controller Display can show several types of continuous MIDI data, but only 
one at a time, of course. You decide which one yourself:

1. Open the Controller Display as described above.

2. Position the pointer over the Controller Icon and press the mouse button.

3. Select a Controller type from the pop-up menu that appears.
The numeric value below the icon shows the number of the displayed 
Controller.
- 250 - 



Changing the size of the Controller Display

Drag the Divider up or down to enlarge or 
shrink the Controller Display.
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Editing Velocity

The velocity values are shown as bars, with higher bars representing higher velocity 
values. Since a velocity value is no Event in itself, but rather a property of a note, 
you cannot create, move or delete velocity values in the Controller display. How-
ever, if you move or delete a note in the Event Display, its corresponding velocity 
bar is moved or deleted as well.

Using the Pencil

To change a series of values, drag over them.

Simply click on the velocity 
bar with the Pencil...

...to change its value.
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Using the Line Tool

To create a ramp of values, for example a fade-in or fade-out, proceed as follows:

1. Select the Line tool.

2. Position the pointer and press the mouse button.

3. “Draw” the outline of the ramp with the 
mouse button pressed.

4. Release the mouse button. The 
velocity values are changed.
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Creating Non-note Events

These include Aftertouch (Channel Pressure), Pitch Bend, Modulation, Volume and 
Pan. There is one very important thing to observe about non-note Events. If for ex-
ample you put in one single MIDI Modulation wheel Event with a value of 63, this 
will be displayed like this:

The figure above might look like an "infinite" series of modulation Events all with 
the value 63, but it is not, it is only one. It is a graph of instantly moving the modu-
lation wheel to position 63 and leaving it there. 

It is important to remember that if you draw, or in any other way input Controllers, 
this makes them stay at the last set value for an infinite amount of time (or until you 
change it the next time). Sustain pedal (damper) for instance, will vary between 0 
and 127 every time you press or release the pedal, but stay at the last value as long 
as you don't move your foot on or off it. Draw in one "foot down" Event, and the 
notes will sustain until a "foot up" Event appears.
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To create a non-note Event, proceed like this:

1. Select what type of data you want to add.
Use the Controller pop-up, as described on page 250.

2. Set up the Snap value to decide what “density” you want for the Events.

3. Hold down the [Option] key.
From here on there are basically three ways to go:

If for example you want to input one Event every 
eighth note, set the Snap value to “8”.

If you want to enter just one Event, click 
once with the Pencil.

If you want to “paint a curve”, drag the 
Pencil (with the mouse button pressed).
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4. Release the [Option] key.

● All values range between 0 and 127, except Pitch Bend, which has a value 
range from -8192 to +8191. For Pitch Bend, value 0 is equivalent to no Pitch 
Bend (the Pitch Bend wheel/lever in center position).

If you want to create a perfect ramp, use the Line tool 
as described in the “Editing Velocity” section.
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Selecting Non-note Events

This is done somewhat differently from selecting notes: You can’t click on an Event 
to select it, rather you have to enclose it in a frame, using the Arrow tool. Note that 
it is the start of the Event that has to be enclosed:

Drawing a rectangle like this... ...selects nothing.

But this rectangle... ...selects one Event.
- 257 - 



Editing Non-note Events

With the Pencil

With the Line Tool

To change one value with the Pencil, 
simply click on it.

To change a series of values, 
drag over them.

“Draw” a line with the Line tool... ...to create a ramp of values.
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Deleting Non-note Events

You delete an Event in the Controller Display just like you delete notes:

• Click on the Event with the Eraser tool.

• Select the Event and press [Backspace].

or

• Select the Event and select Delete from the Edit menu.
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16

List Edit 16
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Overview
Below you will find a description of some of List Edit’s main features:

The Song Position is shown both in the Event list and in the Event display.

With the Insert pop-up menu, you decide which type of Events to input.

Events are shown in the list and in the display to the right.

The Mouse 
position is 
shown in the 
Mouse Box.The Do, To and Goto 

menus. See The MIDI 
Editors - General 
Information.
- 261 - 



The Columns in the List

In List Edit, you can view and edit several types of Events. Common to the various 
Event types are the Start Position, Length and Chn parameters. As you expected, 
these show where an Event starts, its length in ticks and its MIDI Channel value, 
respectively. The table on the next page shows the other List columns and the 
parameters for the different Event types (the rows):

To make all columns appear, drag the Divider as far right as possible.
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There is also a column named Event Type. For all Event types except Control 
Change (see below), this is just an explanatory value that can’t be changed, e.g. 
“Note” for Note Events etc.

Val 1 Val 2 Val 3 Comment

Notes Pitch Note On 
velocity

Note Off 
velocity

Not used

Poly 
Pressure

Note Number Pressure 
Amount

Not used Not used

Control 
Change

Controller Type Change 
Amount

Not used Not used

Program 
Change

Program Number Not used Not used Not used

Aftertouch Pressure Amount Not used Not used Not used

Pitch Bend Bend value (fine) Bend value 
(coarse)

Not used Not used
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Transforming Controller Events

If you change Value 1 for a Control Change Event, you actually change the Controller 
from one type to another. To simplify this, the name of the Controller type is shown in 
the “Event Type” column in the List. You can change the value either in the “Val 1” 
column or the “Event Type” column.

Changing the value in the “Val 1” column...

...will simultaneously affect the “Event Type” 
column, and vice versa.
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Creating Events
1. Use the Insert pop-up menu to decide what type of Event to Insert.

2. Set the Snap value to the smallest position at which you want to enter a note.

3. If you are entering notes, set their length with the Quantize value. 

From here there are three ways to go:

• Select the Pencil or the Paint Brush and draw the Event in the Event display.

• Activate Step Input by clicking on the foot symbol on the Status Bar.
Step programming is described in Step Recording.

• Create notes with the Fill function on the Do pop-up menu, see page 221.

The Event appears both in the List and in the Event Display.
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If you are inputting notes with the tools or the Fill function, they will have...

• The pitch C3.
• A Note On velocity of 110 (unless you have pressed modifier keys while 

inputting the note, see page 243).
• A Note-Off velocity of 64.

If you are using Step Input, the notes will have other properties, as described 
in the Step Recording chapter.
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Editing in the List
The positions and values of Events can be edited in the List, using the regular proce-
dures. There are some things to note:

• If you hold down the [Option] key on the computer keyboard while you’re 
changing a value, all Events of the same type will be set to the same value.
This means for example that all Notes, all Pitch Bend Events or all Control 
Change Events will be affected.

• If you change an Event’s Start Position, the List will be resorted.
The Events are always shown in the order they are played back, with the earli-
est Event at the top and the latest at the bottom.

Editing in the Event Display

Moving Events

You can use the Arrow tool to move Events in the Event Display, much like in Key 
Edit. However, there is one big difference. This is how you should look at the hori-
zontal and vertical positions:

• The horizontal position of an Event in the Event Display is directly 
related to the Event’s Start Position in the Song (just as in Key Edit).
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• The vertical position of an Event in the list is just related to the order of 
the Events. It has no direct relation to time.

An example:

Let’s say we have three Events, positioned at 2.1.0, 2.2.0 and 2.4.0. If you move the middle 
Event a bit to the right...

...it will still keep the exact same vertical position, since its position is still after the first Event 
but before the third.

But if you move the Event further to the right, past the third Event...

...the Event suddenly appears on another vertical position, since the order of the Events has 
been changed.
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Changing the Lengths of Notes

You can click inside a Note Event and drag it to the desired length, using the Pencil 
tool. The new length is shown in the Length column in the List.

Editing in the “Value 2” Display
The graphical display to the right shows Value 2 for the Events in the List (where 
applicable) as horizontal bars. You may use this to change values, create ramps etc.

As you can see in the tables on page 262 in this chapter, the Event types that use 
Value 2 are Notes, Poly Pressure, Control Change and Pitch Bend Events. Perhaps 
the most common use for the display is to edit Value 2 for Note Events, that is, the 
Note On velocity value.

• You do not have to select the Pencil tool to change the bars in the “Value 
2” display; the pointer automatically changes to the Pencil when you 
move it into the display.

For note Events, the bars are black; 
for other Event types they are grey. 
This is to make it easier to 
distinguish different Event types 
from each other.
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Overview
Score Edit displays your music as regular notation. Below you will find a description 
of some of Score Edit’s main features:

The “inverted” notes are selected

The Song Position Pointer

The mouse position is shown in the mouse box and the pitch is shown as a note name in 
the box below. When you move a note, the lower box instead shows the amount of 
transposition in semitones.

If you are editing several Tracks at the same time, the black rectangle 
at the beginning of the score indicates the Active Track.
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• If you are editing one Track, as much of it as possible is shown on several 
staves - one above the other - just as with a score on paper.

• If you edit Parts on several Tracks, they are put on a grand staff (multiple 
staves, tied together by bar lines).

• The number of measures across the screen depends on how many notes 
there are in each measure.

• The last measure is indicated by a double bar line.

Getting the Score displayed correctly

Time Signature

Score Edit always uses the Time Signatures specified in the Master Track.

Staff Settings

When you open Score Edit for a Part recorded in real-time, the score may not look as 
legible as you would first expect. The Score editor can ignore the minor time vari-
ances in performance and make a neater score almost instantly. To achieve this, there 
are a number of settings in a Staff Settings dialog box that determine how the program 
displays the music.
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There are two ways to open the Staff Settings dialog:

• Double click in the white area to the left of the staff.

• Activate a staff by clicking on the first bar line on any of the staves in the 
window. Then select “Staff Settings” from the Do pop-up menu.
The Staff Settings dialog appears: 

● The settings you do in this dialog box are independent for each Staff (Track), 
but common for a piano staff you create with Split Staff Mode.
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Key and Clef

The correct Key and Clef are set using the two scroll bars in the Key & Clef section.

Display Quantize

Since the actual timing of recorded notes often varies slightly from the desired 
notation, the program can be told to “allow” such variations, and still display notes 
as if they were played perfectly in time. This is done using the Quantize section of 
the Staff Settings dialog.

● These are only display values used for the graphics in the Score Editor. They 
do not affect the actual recording in any way.

If you check the “Auto Clef” checkbox, 
the program attempts to guess the correct 
clef, judging from the pitch of the music.

To set Key and Clef for the lower Staff in 
Split mode (see below), activate the Lower 
Staff checkbox.
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Here is a description of the functions:

Parameter Description

Notes The smallest note value to be displayed. Set this to the smallest sig-
nificant note value used in your music. If for example you set this to 
eighth notes, no note values smaller than eighth notes will be dis-
played. If you set it to a triplet value, the program expects all notes 
on this staff to be triplets.
This setting is partly overridden by Auto Quantize (see below).

Rests The smallest rest value to be displayed, as with the “Notes” setting 
described above.

Auto Quantize Generally, if your music contains mixed triplets and straight notes, 
try activating this function by selecting “Position” from the pop-up 
menu. Otherwise leave it off.

Auto Quantize uses involved methods to make your score look as 
legible as possible while allowing you to mix straight notes with tu-
plets (triplets) in a Part. But, Auto Quantize also uses the (display) 
Quantize value. If it can't find an appropriate note value for a cer-
tain note or group of notes, it will use the set Quantize value.
If the part is imprecisely played and/or complex, Auto Quantize 
may have a problem “figuring out” exactly what you “mean”.
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Staff Mode

This pop-up lets you choose between Single mode (the “normal” mode) and Split 
mode. When Split mode is chosen, the Part is split on the screen into a bass and treble 
clef, as in a piano score. You use the Split Point value field to set the note where you 
want the split to occur. Notes above the split note will appear on the upper staff, and 
notes below the split note will appear on the lower staff.

Before and after setting a split at C3.
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Switches

These provide additional options for how the score should be displayed:

Parameter Description

Clean Lengths When this is activated, notes that are considered to be chords will 
be shown with identical lengths. This is done by showing the 
longer notes as shorter than they are. When Clean Lengths is turned 
on, notes with very short overlaps are also cut off; a bit as with No 
Overlap (see below), but with a more subtle effect. 

No Overlap When this is activated one note will never be shown as overlapping 
another, lengthwise. This allows long and short notes starting at the 
same point to be displayed without ties; the long notes are cut off in 
the display. This will make the music more legible.

An example measure with No Overlap deactivated...

...and with No Overlap activated.
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Syncopation When this function is on (ticked) syncopated notes are shown in a 
more legible way.

This is a dotted quarter at the end of a bar when Syncopation is Off...

... and when it is On.

Shuffle Activate this function when you have played a shuffle beat and 
want it displayed as straight notes (not triplets). This is very common 
in jazz notation.

Flat Beams When this is ticked, the beams over the notes will be flat (as op-
posed to slanted).

No Beams When this is ticked, there will be no beams whatsoever in the Part. 
This is good for example for vocal scoring.

Track Name When this is activated, the name of the Track is shown at the begin-
ning of the Staff.

Parameter Description
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Closing the Dialog

• When you have finished with the settings, close the dialog by clicking the 
OK button.
This applies the settings to the active Staff/Track.

● Remember that the Staff settings are done independently for each Track.
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Editing several Tracks
You may edit several Tracks simultaneously in Score Edit. The Tracks are shown as 
multiple staves, tied together by bar lines and placed in the order they appear in the 
Track List.

The Song Position Pointer

Selected notes
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The Active Staff

Just as in the other editors, all MIDI input (as when recording from your instrument) 
is directed to one of the Tracks, here called the Active Staff. The Active Staff is indi-
cated by a black rectangle in the left part of the first visible bar.

To make another Staff active:

• Click anywhere in the Staff you want to activate.

or

• Step to the Staff you want to activate, using the [↑ ] and [↓ ] keys on the 
computer keyboard.

The Active Staff rectangle
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Creating Notes and Rests
When you input music “by hand” in Score Edit, you can use the Note and Rest 
tools. The length of the note or rest to be input, is determined by the Quantize value. 
However, the easiest way to input notes, is to use the note symbols in the Toolbar:

• To input a note, first click on the desired note value in the Toolbar (the 
Note tool is automatically selected), then click in the staff where you 
want the note.
If you want to insert a triplet or dotted note, click on the “T” or “·” button 
when you select the note value.

When you change Quantize value, or click on a note button on the Toolbar, the shapes of the 
Note and Rest tools are changed.

• To input rests, select the Rest tool, then proceed as when inputting notes.
There is one big difference between inputting notes and rests:

● Rests are always inserted (as if Insert was activated, see page 299) into the 
music.
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Manipulating Notes
There are a few special features for manipulating notes:

Moving and Transposing Notes

• Use the two mouse boxes to determine where to place notes.

When you move several notes, the upper mouse box shows the position of 
the note you clicked on when starting to drag.

• If you hold down [Command] and transpose a note, it will only be trans-
posed within the set key.
If, for example, the key is C major (set in the Staff Settings dialog), you will 
only transpose to notes belonging to the C major scale.

• Holding down [Shift] restricts movement to either up/down or left/right.
If for example you want to transpose a note, select it, hold down [Shift] and 
move it vertically. This way, the note is not accidentally moved to another 
position in the bar.

The upper box shows the position of the 
moved note (as bars, beats and ticks).

The lower box shows the pitch when 
inputting notes, and the transposition 
value when moving notes.
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Changing the Length of Notes

You may use the Note tool to change the lengths of notes in the score:

1. Select the Note tool.

2. Click on the desired note value button on the Toolbar.

3. Hold down [Option] on the computer keyboard and click on the note you 
want to change.
The note gets the selected note value.

● Please remember that the Display Quantize settings in the Staff Settings dialog 
affect how notes are displayed. If the above procedure doesn’t give the ex-
pected result, check the Display Quantize settings.
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Joining Notes

The Glue Tube tool allows you to join two or more notes of the same pitch.

• Click on a note with the Glue Tube tool.

The note is joined to the next note with the same pitch.

Splitting Notes

The Scissors tool does the opposite of the Glue Tube; it splits two tied notes into 
separate notes:

• Click on the second of two tied notes.

The notes are split into two.
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Enharmonic Shift

The buttons to the right on the toolbar are used to shift the display of selected notes 
so that for example an F# (F sharp) is instead shown as a Gb (G flat) and vice versa:

1. Use the arrow tool to select the note(s) you want to affect.

2. Click on one of the buttons to display the selected note(s) a certain way.

The middle button resets the notes to the original display. The other four options are double 
flats, flats, sharps and double sharps.

Flip Stems

By selecting this item from the pop-up Do menu, you change the stem direction of 
the selected note(s).

Deleting Notes and Rests

This is done with the Eraser tool, the Backspace key or the Delete item on the Do 
pop-up menu, as in the other editors.

● Deleting a note is the same as replacing it with a rest, while deleting a rest 
automatically moves the next note or rest to the position of the deleted rest.
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Adding Text
Cubasis AV lets you enter text anywhere in the Score. This can be used for lyrics, 
comments or performance instructions. Proceed like this:

1. Select the “Text” Tool.

2. Click anywhere in the score.
A text input line dialog box appears. 

3. Enter the text and press [Return] when you are ready.
The font, style and size of the text depends on the settings in the Text Settings 
dialog, reached from the Do pop-up menu.
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Changing the Font and Size

If you wish to change the font and size for some text you already put in, proceed as 
follows:

1. Select the text by clicking on it with the Arrow tool.
You may select several lines of text in the Staff, by holding down [Shift] and 
clicking on them.

2. Select “Text settings...” from the Do pop-up menu.

3. Use the Font pop-up, the size setting and the style options in the dialog 
box that appears.
The fonts you find on the menu depend on what fonts you have installed in 
your computer.

4. Click “OK” to close the dialog box and give the selected text the settings 
you have chosen.
The font and size settings you just made will also apply to all the text you input 
from now on (until you change the settings, of course).
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Editing text

To edit text, double click on it with the Arrow tool and enter new information on the 
input line, just as when you put in the text the first time.

Cutting and Pasting Text

Using the keyboard short-cuts (not the menus) you can Cut and Paste text. Select a 
“block” of text by clicking on it with the arrow tool, press [Command]-[X] or 
[Command]-[C] to Cut or Copy. Click for a new insertion point, and press 
[Command]-[V] to Paste. 

Moving and Duplicating Text

Text “blocks” can be moved freely within the “page”, one at a time or together, just 
drag it/them to the new location. 

If you hold down [Option]when you drag you are making copies instead of just 
moving.

Deleting Text

Text “objects” are deleted just like notes, rests or other objects.
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Title, Comment and Copyright
There are three standard text elements on the first page of your score, which you 
may enter in the dialog box that comes up when you select “Score Title...” from the 
Do pop-up menu. 

1. Use the Text Element pop-up to select an element to edit.
“Title” is the title of the Score. It is printed at the top of the first page, and is 
always centered.
“Comment” is positioned just below the Title.
“Copyright” is positioned at the right side of the first page, just above the first 
system.
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2. Use the pop-up menus and check boxes to the right, to select font, size 
and attributes for the selected element.

3. Type in the text in the text box below the Text Element pop-up.

4. Click OK.

● None of these elements are visible on-screen but will be printed out.

Printing
To print your score, proceed as follows:

1. Make settings for the Text, Title, Comment and Copyright elements, as 
described on the previous pages.

2. Select Page Setup from the File menu.
This opens the Page Setup dialog, which is a standard Macintosh dialog, with 
one exception (the Margins settings, described below).

3. Choose paper size and direction, and make any other desired settings, 
just as when printing from a word processor or layout program.
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4. If you need to, change the size of the margins by setting new Left, Right, 
Top and Bottom values.
Please note that each printer has a minimum margin. To automatically set the 
values to this minimum, click on the Default button.

● If you set margins smaller than the Default values, everything on the page 
might not get printed!

5. Close the Page Setup dialog by clicking OK.
The Page Setup settings are included when you save the Song.

6. Select Print from the File menu or press [Command]-[P].
A standard Macintosh Print dialog opens. Its options depend on the type of 
printer you use (explained in the manual for your Macintosh or printer). 
Normally you should be able to decide to print a number of copies, all pages, 
or just a specified range, etc.

7. Click Print.
Provided that you have your printer connected correctly, your score will now 
be printed.

8. Click OK.

● Note that printing is only available from Score Edit!
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Introduction
Step Input is when you enter notes one at a time (or one chord at a time). This is 
useful when you know the part you want to record but are not able to play it exactly 
as you want it.

Preparations

1. Create an empty Part, as a container for the notes you are about to Step 
Record.
You can of course also use an exisiting Part.

2. Open the Part in a MIDI editor of your choice.
Below we will use Key Edit, but it doesn’t matter which you select.

3. Click on the Step button.
This automatically activates the MIDI In icon and the Step Position box.

Click the Step button...

...the MIDI connector is 
automatically activated...

...and the Step 
Position box appears.
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Determining Note Lengths and Positions

• To set the length of the notes you are about to input, adjust the editor’s 
Quantize value.
If for example you set this to “16” all notes you input will be sixteenth notes.

• To set the “spacing” between the notes and chords, adjust the editor’s 
Snap value.
If you set this to “8” all notes will appear on eighth note positions.

Setting the Position for the first note

To set the position where you want the first note to appear, adjust the regular Song 
Position (for example on the Transport Bar) and the Step Position is automatically 
set to the same value.

Note length

Note “spacing”
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Selecting a Track for input

If you are editing several Tracks at the same time, you must decide which Track to 
enter notes into by making a Part/Track active. This is just as when recording from 
an editor, see page 213.

Entering notes and chords

1. Play one key or a chord.
If you just played one key it appears as soon as you release it. If you play a 
chord it appears when you release the last key. In either case, the velocity you 
played is recorded with the note.
No matter how long you hold down the key, the note will get the length set in 
the Quantize box.

2. Enter the note(s) for the next position.

When you release 
the key, the note 
appears and the 
Step Position box 
advances one step.
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Adding Rests

To move one step without entering any notes, press the [Tab] key on the computer 
keyboard.

Changing note values and positions as you go along

• If you want to enter notes of another length, simply change the Quantize 
value at any point.

• If you want to input notes with a different “spacing” simply adjust the 
Snap value.

• If you want to move to a completely new position, change the Song Posi-
tion or use Fast Forward or Rewind.

• To move one step back or forward in time, use the [←] and [→] keys. 
The Song Position Pointer shows you the current position.

If you change the Song Position...

...the Step Position is 
set to the same value.
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If you make a mistake

If for example you entered a note with the wrong pitch or made a mistake when 
playing a chord, press [Backspace]. This deletes the last note/chord you entered, 
and moves the Step Position one step backwards. You can press this key repeatedly 
to “delete backwards”.

You can also use the tools and menu for editing (deleting, moving etc.).
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Using the Insert button

If the Insert button on the Status Bar is activated, the notes are inserted rather than 
added. That is, any existing notes are moved to a later position to make room for the 
new notes.

The Insert button

With Insert on, and 
the Step Position 
here...

...the new note is 
inserted, and the 
following notes are 
“pushed forward”.
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Playing back

You can activate playback at any time and from any position, to hear what you have 
done. Please note, though, that moving the Song Position also moves the Step 
Position.

When you are finished

When you have entered all the notes you want, don’t forget to deactivate step mode 
by clicking on the MIDI In button.

Entering notes from the computer keyboard
If you press [Insert] (on an extended computer keyboard), a note is inserted at the 
Step Position. It will take on the same default values as when you use Fill (see 
page 221).

Setting the pitch

To change the pitch of the next note you enter with the [Insert] key, press [↑ ] (one 
semitone up) or [↓ ] (one semitone down).

Click on the “MIDI connector”... ...and the Step button is automatically deactivated.
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Using the Master Track
The Master Track is a special Track that contains time signature and tempo events 
only. Use this Track when you want to incorporate time signature and tempo 
changes in your music. If your Song does not contain any time signature or tempo 
changes, it is easier to set the tempo on the Transport Bar, as described in the chapter 
“Playback, Tempo and the Transport Bar”.

• To make Cubasis AV follow the tempo settings on the Master Track, click 
on the Master button on the Transport Bar so that it is activated.

You may also press [M] on the computer keyboard to activate/deactivate the 
Master Track.

● Cubasis AV always follows the Time Signature changes set up on the Master 
Track. By activating and deactivating the Master Track, you decide if Cubasis 
AV is to follow the Master Track tempo settings or the tempo set on the Trans-
port Bar. 

Master activated
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● Please note that changing the tempo in Cubasis AV will not change the tempo 
within any recorded audio! The Master Track tempo only affects when each 
Audio Part starts, not the actual contents of the Part.
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The Master Track Editor
There are two ways to display the Master Track and its entries:

• Select Master Track from the Edit menu.

• Press [Command]-[M] on the computer keyboard.

The three columns in the list display each entry's position, tempo and time signature value.

The Tempo and Time Signature settings are shown in a list which can be scrolled 
using the scroll bar or the [↑] and [↓] keys on the computer keyboard. There are 
always two entries at the top of the list, the Master Track is never empty. These two 
are the initial tempo and time signature, positioned at 1. 1. 0.
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Editing Events in the List

You change the Tempo and Time Signature values directly in the list, using the nor-
mal value editing procedures. Please note:

• You cannot change the position of the Events in the list.
Instead of moving an Event, use Cut and Paste, as described on page 307.

Inserting Tempo or Time Signature Events

To insert new Events into the list, you use the Functions pop-up menu in the top left 
corner of the editor:

1. Use the Song Position value box in the top right corner to set the position 
where you want to insert the Event.

2. Pull down the Functions pop-up menu and select “Insert Tempo” or 
“Insert Signature”.
The new Event is added to the list. Time Signature Events are always positioned 
at the start of a bar.

3. Edit the Event to give it the desired value, as described above.
- 305 - 



Deleting Events

1. Click on the Event you want to delete, to select it.

• If you want to select a range of Events, click on the first Event, hold down 
[Shift] on the computer keyboard and click on the last Event.
All Events in between are selected.

• If you want to select several Events, but not all in between, hold down 
[Command] and click on the Events.
Only the Events you click on are selected.

2. Select Delete from the Edit menu, or press [Backspace] on the computer 
keyboard.
The Event is removed from the Master Track.
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Cut, Copy and Paste

You can use the Cut, Copy and Paste commands on the Edit menu (and their key-
board equivalents) on the Master Track Entries.

1. Select one or more events and Cut or Copy them.

2. Set a new Position value using the Song Position value field. 

3. Select Paste.
The entries will get pasted in, beginning at the position set in the value field.

• A Pasted entry will not replace an existing Entry at the same Position.

• A Time Signature entry can only be pasted in at the downbeat of a bar.
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Other Functions

On the Functions pop-up menu in the top left corner, there are some other functions 
for the Master Track:

Hide/Show Tempi and Time Signature

These two menu items allow you to Hide either all Tempi or all Time Signatures. 
When either is hidden, its menu item changes from "Hide" to "Show".

Clear Tempi

This function simply deletes all tempo entries but the first from the list.

Undo

Any deletion, copying or creation of events in the Master Track can be undone by 
selecting Undo from the Edit menu or by pressing [Command]-[Z] on the computer 
keyboard. Value changes cannot be undone. 

Closing the Master Track Editor

Close the editor window by clicking its close box or pressing [Return] on the compu-
ter keyboard.
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What is QuickTime?
QuickTime is an extension to the Macintosh operating system that allows you to 
play back movies in a window on your Macintosh.

What can I Do with QuickTime in Cubasis AV?
• You can open any QuickTime movie, play it on your screen, synchronized 

with Cubasis AV’s playback.

• You can export an audio track from a QuickTime movie, and import it 
into a Track in Cubasis AV.
This allows you to edit the audio data there, cut out unwanted parts, add music, 
etc.

• You can export audio that you have prepared in Cubasis AV and import it 
into a QuickTime movie, replacing the existing audio track.

These features allow you to use Cubasis AV as an audio and music editing tool for 
your QuickTime movies.
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Playing Movies in Sync with Cubasis AV

Setting Up and Loading Movies

1. Select “Setup Movies” from the “Movies” submenu on the File menu.

2. Click the “Add Movie” button.
The standard QuickTime file dialog appears. This shows a Preview still image 
of the movie to the left. If there is no Preview you can create one for the se-
lected movie file, using the “Create” button.

3. Locate the movie file, select it and click Open.
The file is added to Cubasis AV’s movie list.

4. If you like, Open more movies.
Cubasis AV can have many movies loaded at the same time, and even play 
them all back simultaneously.
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5. When you are done, close the “Setup Movies” dialog by clicking OK.

Saving the Movie List

When you save the Song, the list of movies used is saved with it. This does not 
mean that the actual movies are copied into the Song file, only that the program 
keeps track of which movies were used and where on your hard disk(s) they are.

Added movies
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Using Remove, Find and Open Movie

There are a number of additional options in the Setup Movies dialog:

Remove

• To Remove a movie from the list, select it and click the Remove button.

Find

If you use the Finder to move a movie file, for example from one hard disk to another, 
Cubasis AV won’t be able to find the movie the next time you load the Song. If this 
happens, the title will be greyed out in the list.

1. To find the file, click the Find Movie button.

2. Use the File dialog that appears to locate the file.

3. Select the file and click Open.
The file is now located and its title is again “black” in the list.

Open

• To Open the movie in a window, select it in the list and click Open 
Movie.
This can also be done using the list on the Movies submenu, see below.
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Opening and Closing Movie Windows

Open

On the “Movies” submenu on the File menu, you will find a Movies list containing 
the “added” movies.

The Movies sub-menu

• To open a movie in a window, select it from the sub-menu.

Close

• To close a movie window, click its close box.
If you have changed the Offset setting for the movie, the program asks you if 
you wish to save this. If you do, this setting will be saved into the movie file 
itself (the same dialog appears if you Quit the program with movie windows 
open).
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Playing Back

The movie window’s 
transport bar.

Use this to set where the movie 
should start in the song.

The actual 
movie.

This turns “movie 
sync to Cubasis AV” 
on/off.
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Offset

The movie window has a Start Time setting. This can be used to set a start point for 
the movie in the Song. The value is in time code (SMPTE) format; “hours:min-
utes:seconds:frames:subframes”.

If for example you set this to “0:1:0:0:0”, the movie will start one minute in, from 
the beginning of the Song.

Playback

• When you activate playback in Cubasis AV, the movie plays back in sync.
• To turn off synchronized playback, deactivate the “On Line” function in the 

movie window.
• When you activate playback in the movie window, only the movie will play, 

regardless of the “On Line” setting.

● The audio in the movie is not played back when you play the movie from 
within Cubasis AV.

Positioning

The positions of Cubasis AV and the movie are completely linked. This means that 
when you fast forward, rewind, locate etc, the movie will be positioned accordingly. 
Also, when you perform the same operation in the movie window, Cubasis AV’s 
Song position will move with the movie’s.
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When you “position” 
Cubasis AV, the movie 
“locates” to the same 
position automatically.
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Importing and exporting audio tracks
Built into Cubasis AV is a QuickTime utility called MovieTracks that allows you to 
import and export audio data to and from QuickTime movies. We will first explain 
how this utility works, and then outline an example of its practical use.

Opening a movie in the MovieTracks window

1. Pull down the File menu and select “MovieTracks…” from the “Movies” 
submenu.
The following window appears.

This menu is used to select a 
track in an open movie.

This menu contains a 
number of functions.

This area displays 
the movie.
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2. Pull down the “MovieTrack Functions” pop-up and select Open Movie.

3. Locate and open the movie.
It appears in the left part of the window, from where you can play it back , like 
in any QuickTime window.

The Controls in the MovieTracks windows

Movie panel

On the left side of the window, a regular QuickTime panel allows you to play the 
movie.

Tracks pop-up

This is used to select one of the Tracks in the movie (the video track, the audio 
track, etc.). Whatever changes you make with switches and sliders will only affect 
the track selected here.

Active checkbox

This is used to turn on/off the selected track. When a track is deactivated, it will not 
play. When you save the movie you also have the option of excluding deactivated 
tracks, see below.
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Sliders

These allow you to make adjustments to the track selected with the top (Tracks) 
pop-up. Any changes you make will only affect this track. For large changes, drag 
the handle with the value. For smaller changes, click the “+” or “–” buttons.

Name: Description:

Offset This allows you to make a track start later than the others. This is 
useful to for example make adjustments to a narration or music track 
that doesn’t play “in sync” with the video.

Volume This only applies to audio tracks, and allows you to adjust its play-
back level.

Balance/Pan This only applies to audio tracks and allows you to adjust the stereo 
balance of an audio track (left/right).
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MovieTrack Functions pop-up

This menu contains the following four options:

• Open Movie
This presents you with a regular QuickTime Open dialog, that allows you to 
open any QuickTime movie file you have on your disks.

• Save Movie
This allows you to save the movie, including the changes you have made in 
MovieTracks. See page 326 in this chapter for details.

• Import Audio
This allows you to add an audio track to your movie. This can either be a sepa-
rate audio file or you can extract the audio out of another movie. See page 324 
in this chapter for details.

• Export Audio
This allows you to export an audio track in a movie into a separate audio file. 
See page 322 in this chapter for details.

• Remove Track
This removes the selected track from the movie, altogether.
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Extracting Audio Data from Movies (Export Audio)

MovieTracks allows you to export any audio track in a QuickTime movie and convert 
it into a regular audio file that can be imported into Cubasis AV.

The file is saved in AIFF format (the standard audio file format on the Macintosh). 
Options in the dialog allows you to control the sample rate and bit resolution of the 
file. The main reason to change any of these values is if you want to use the files in 
a program that requires certain sample rates and resolutions (Cubasis AV does, see 
below).

Proceed as follows:

1. Make sure the Tracks menu indicates that the correct audio track is 
selected.
If, not, select the desired track from the top pop-up.

2. Pull down the “MovieTrack Functions” pop-up and select Export Audio.

An audio track selected.
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3. Find a location for the file, type in a name and fill out the options, as follows:

4. Click Save.
The new file is created on your hard disk.

Option: Description:

Export in original 
format

This saves the file in AIFF format, without changing the sample 
rate or bit resolution.

Export and Convert 
to...

This saves the file and adapts its sample rate and resolution to 
the standard values for Cubasis AV. Use this option if you want 
to import the files into Cubasis AV.

Export as: This allows you to select from a number of sample rates and 
from the two possible bit resolutions, using pop-ups.
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Adding Audio to Movies (Import Audio)

If you have prepared an audio file in Cubasis AV or other program you can import 
it into an existing movie.

• The file must be in AIFF format (the standard audio file format on the 
Macintosh).

• Any sample rate is allowed.
If you like, MovieTracks can convert the sample rate when importing it. See 
below.

• The file can be in 8 or 16 bit format.

• The file will appear as a new track which gets added to the existing audio 
tracks in the movie file.
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Proceed as follows:

1. Pull down the “MovieTrack Functions” pop-up and select Import Audio.

2. Fill out the options, as follows:

3. Locate the file and click Open.
The file gets added to the movie as a new track. 

If required, you can now select the track and make adjustments to its volume, stereo 
balance and starting point, as described on page 320 in this chapter.

Option: Description:

Import in original 
format

This adds the file as a new track, without changing the sample 
rate or bit resolution.

Import and Convert 
to...

This adds the file as a new track and adapts the sample rate and 
bit resolution to the existing audio track(s) in the movie.

Import as: This allows you to select from a number of sample rates and 
from the two possible bit resolutions, using pop-ups.
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Saving a Movie

When you save a movie, the following information is included:

• Any track you have imported since you opened it.
You can decide not to save deactivated tracks, see below.

• Any setting changes you have made to the tracks (offset, volume etc.).

Saving

1. Pull down the “MovieTrack Functions” pop-up and select Save Movie.

2. Find a location for the file, type in a name and fill out the options, as 
follows:

Option: Description:

Save as self con-
tained.../Save nor-
mally...

A self contained movie contains all the information needed for 
playing it back, in one file. A file with dependencies, on the 
other hand, might be “assembled” from other files. Normally, 
you would choose “self contained”. For more information about 
this, see the Apple QuickTime documentation.

Make PC compati-
ble movie.

If this movie will ever be played back on a QuickTime equipped 
PC computer, make sure this check box is activated when you 
save.
- 326 - 



3. Click Save.
The new file is created on your hard disk.

Editing the audio for a movie - an example

To get an idea of how the various options in Cubasis AV can be used to edit and add 
audio to a movie, please read the following example:

Let’s say you have recorded a movie with a video camera and transferred it to your 
Macintosh computer. This contains some dialogue recorded together with the pic-
tures. You want to make some small adjustments to the existing audio (remove 
some parts, replace some bits, add some effects etc) and add some music. Proceed 
as follows:

1. Open the movie in MovieTracks, and export the audio track, using the 
option that converts the sample rate to Cubasis AV’s preferred rate.

2. Import the newly created audio file into a Track in Cubasis AV.

Disable playback 
optimizations

When this is activated, editing the movie will be faster, but play-
back may be “jumpier”. If this is the final edit of the movie, 
make sure this option is deactivated.

Only save active 
Tracks

When this is checked, only the tracks that are activated in the 
MovieTracks window, will be saved.
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3. Set up a movie playback window that plays back the video in sync with 
the Song.

4. Make the edits to the audio track (possibly adding new recordings), until 
the existing audio is playing back as you want it.

5. Create the music tracks.

6. Set up a final mix for all the audio (both the dialog and the music).

7. Use the Export Audio command in Cubasis AV to convert the entire 
Arrangement to a single audio file.
See the chapter “Importing and Exporting Audio” for more information about 
this feature.

8. Use the MovieTracks window to remove the existing audio track from the 
movie and replace it with the file you just created (by importing the new 
file).

9. Make any adjustments you find necessary.

10.Save the movie in self contained format.
It will now play back with new audio, complete with music and edited dialog.
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Saving

Which should I choose - Song or Arrangement?

When you save your music in Cubasis AV, there are three document formats you 
can use for saving your music: Song, Arrangement or MIDI File. You should only 
choose MIDI Files if you want your music (MIDI only - no audio) to be playable in 
other sequencers. If you want to save your music for further use in Cubasis AV, you 
should use either the Song or the Arrangement format:

Song

When you save a Song, the following is saved:

• All the Arrangements.
• All settings in dialogs, on the Transport Bar, etc.
• All Audio Parts and segments, and references to their respective audio files.
• The Pool.
• The settings in the Mixer windows.

Arrangement

When you save an Arrangement, the following is saved:

• All the things you see in one Arrange window; the Tracks, the Parts, the Inspec-
tor settings etc.
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The audio files, however, are stored in the Pool, and the Pool is not part of the Ar-
rangement. This means that if you only save an Arrangement, there will be no audio 
files for them to reference to! Therefore:

● When doing audio work with Cubasis AV we recommend that you always 
save complete Songs!
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This table shows the advantages and disadvantages of the two formats:

File Format Advantages Disadvantages

Arrangement • Takes up little disk space.

• Does not contain “unneces-
sary” settings if all you want to 
save is MIDI music.

• Opening an Arrangement 
does not affect settings in dialog 
boxes and on menus, which, in 
some situations, is an advan-
tage.

• A saved Arrangement can be 
opened and incorporated into 
any other Song.

• Does not contain any refer-
ences to audio.

• Does not contain a complete 
“snapshot” of the program’s 
“state”.

Song • Contains references to all au-
dio information and data.

• Contains more than one Ar-
rangement.

• Saves all the settings on all 
menus, in all dialog boxes etc.

• Takes up more disk space than 
the Arrangement file format, 
even if you only have one Ar-
rangement in the Song.
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Performing the Save

1. Pull down the File Menu and select “Save As...”
The file dialog appears.

2. Use the standard Macintosh buttons and file list to find the location on 
your hard disk where you want to save the file.

3. Use the file type selectors to select a format, Song or Arrangement.

4. Type in a name for the file.

5. Click the Save button.

File List
Standard 
Macintosh 
File naviga-
tion buttons

Cubasis AV 
File Type 
Selectors

File Name
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About the Autoload Song

Each time you launch Cubasis AV, a default Song is opened, called the Autoload 
Song. You can customize this default Song, simply by setting up the program as 
you want it (resizing and moving the Arrange window, configuring the Track list, 
changing the Double Click Opens setting, etc.) and saving the Song in the same 
folder as your Cubasis AV program, under the name “Autoload” (make sure you 
type the name exactly like that, but without the quotes of course!). Next time you 
launch Cubasis AV, the Song you saved will be loaded automatically.

Using Save

On the File menu you will find a menu item called “Save”.

• If you have already saved your Song once (using “Save As...”) this menu com-
mand will save your Song without asking for a file name and location. The file 
you save now will simply overwrite the earlier version.

• If you have not yet saved your Song, selecting “Save” is the same as selecting 
“Save As...”.

The “Save” command can also be executed by pressing [Command]-[S] on the 
computer keyboard.
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Opening
1. Select Open... from the File menu.

The Open dialog appears.

2. Use the file type selectors to select which type of file you want to open, 
Song or Arrangement.

3. Use the standard Macintosh buttons and file list to display the correct 
folder on your hard disk.

4. Click on the file in the file list.
The list will only show documents of the selected type.

5. Click Open.

File List

Standard 
Macintosh File 
navigation 
buttons

Cubasis AV 
File Type 
Selectors

File selected 
for opening
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About opening Songs

If the file is a Song, you will be prompted with a reminder that the Song you open 
will appear instead of the Song you have on screen now. If this is not what you 
want, Cancel and Save the existing Song first.

About opening Arrangements

If the file is an Arrangement, it will appear as a new window on screen, in addition 
to any Arrange windows already open.

Opening Documents from the Finder

Double clicking on a Song file in the Finder will launch Cubasis AV. However:

• Audio files should not be used to launch Cubasis AV, that is, don’t double 
click on them in the Finder to start Cubasis AV.

• Double clicking on a Pool document in the Finder does not open the Song the 
Pool was last used in. Instead you get the Autoload Song.
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Opening Songs made by other Steinberg programs

Cubasis AV can open Song files made in other Steinberg sequencer programs such 
as Cubase and Cubasis. However, there are some restrictions:

• If the Song contains more than 16 MIDI Tracks and 8 Audio Tracks, the 
excess Tracks are removed.
For Audio Tracks, this means that some audio may not be included. MIDI 
Parts on the excess Tracks are instead moved to the Track in Cubasis AV with 
the same MIDI Channel.

• In more advanced Steinberg programs, there are additional settings and 
parameters, which are ignored when opening the file in Cubasis AV.
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Exporting an Arrangement as a MIDI File
You might want to export an Arrangement as a Standard MIDI File, so that it can be 
loaded into other computer programs or hardware sequencers, for example.

● A Standard MIDI File contains MIDI data only - no audio. Any audio in your 
Arrangement will automatically be excluded from the created MIDI file.

1. Mute all the MIDI Tracks you don’t want included in the MIDI File.

2. Pull down the File menu and select “Export MIDI File”.
A file dialog appears.

3. Select a name and location for the file.
If you plan on playing the MIDI file on another platform, such as a PC, you 
should name it “XXX.MID”, where XXX is a name with up to eight characters.

4. Click Save.

A MIDI File created by Cubasis AV.

• Cubasis AV normally saves MIDI files in format 1.
However, if you Export a MIDI File with only one Track unmuted, a MIDI File 
of type 0 is created.
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Importing a MIDI File
You can import Standard MIDI files into Cubasis AV, either into the currently se-
lected Arrangement or into a new Arrangement of its own:

1. If you want to include the MIDI file in an existing Arrangement, select 
this Arrangement and move the Left Locator to where you want the MIDI 
file to start.

2. Pull down the File menu and select “Import MIDI File”.
A dialog box appears, asking if you want the file to appear in a new Arrange 
window or if you want to merge the MIDI File into the current Arrangement.

3. Select one of the options.
The MIDI file is imported. The data is automatically split up into shorter seg-
ments (Parts) to make it easier to edit the music in the Arrange window.
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About Audio Files

Audio File Formats

All audio files created by Cubasis AV are AIFF files with 16 bit resolution.

However, using the Import Audio command in the Pool, you can load audio files in 
the formats Sound Designer II or AIFF. When you do this, the program expects the 
imported file to have the sample rate 44.1 kHz. If the audio has another sample rate, 
it will not play back normally.

Backing Up

Needless to say, it is essential that you back up your audio data regularly, preferably 
on to another device.
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The Apple Menu
The Apple Menu (the menu under the apple icon in the top left corner of the screen) 
contains one item related to Cubasis AV:

About Cubasis AV...

This opens the About Cubasis AV dialog. The dialog contains:

• The version of the program (displayed in the top left corner).
• The Available Memory figure (giving you an approximate idea of how much 

memory is available for recording new MIDI music).
• A list of people involved in making the program.

To close the About Cubasis AV dialog, click on it or press [Return] on the computer 
keyboard.
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The File Menu

New

Selecting this menu item, or pressing [Command]-[N], creates a new Arrange win-
dow, called Untitled. You can change this name by double clicking on it in the title bar 
of the window.

● The maximum number of open Arrange windows at any time depends on 
memory, but the upper limit is always sixteen.
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Open...

This item brings up a dialog, which is used to open Cubasis AV files. With the File-
type radio buttons, you select which type of files should be displayed in the file 
selector box, Songs or Arrangements:

Song

This option opens up a complete Song including all information and settings.

A Song document in the Finder
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Arrangement

Opens up an Arrange window including all Arrangement-specific settings. If you 
hold down [Command] while clicking on Open, this dialog box appears:

Regardless of whether you now choose to replace the existing Arrangement or put 
the new Arrangement in the background, you can do this without interrupting the 
music. This makes it easy to load new music while playing, e.g. in a live situation.

An Arrangement document in the Finder
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Close

Closes the Active window. If the window is an Arrangement, you get this dialog:

Option Description

Set Aside The window is closed, but the Arrangement is still kept in memory and 
still exists on the Windows menu. The window can be opened again 
by selecting it from there.

Save The Arrangement is saved, and the window is closed. If the Arrange-
ment hasn’t already been saved, you are asked to give it a name.

Don’t Save The Arrangement is closed and erased from memory. If you want to 
open it again some other time, save it to disk before closing.

Cancel Aborts the entire operation.
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Save

This saves any changes made to the Song since you last saved. If the Song hasn't 
been saved before, the Save dialog comes up asking you to specify a name and 
“location” for the Song.

Save as...

The Save as... item brings up a dialog box that allows you to Save to disk and spec-
ify a name and location for the file. 
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Which file type (Song or Arrangement) you will save is determined by the Filetype 
radio buttons:

Song

This saves the whole Song, which means a number of things, some of which can 
also be saved individually:

• All Arrange windows.
• The Pool, including all audio references.
• All preferences and settings.

Arrangement

This saves the active Arrange window. If you give the Arrangement a new name 
when saving, the name of the Arrange window in Cubasis AV will be changed too. 
The Arrangement contains:

• The contents of the Arrange window.
• The tempo setting on the Transport bar.
• The Mastertrack contents and its on/off status.
• The Solo switch setting.

The Arrangement does not contain any audio-related data.
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Revert To Saved

This command restores the Song to the last saved version. Any changes you made 
since you last saved are lost. You can use this command as a way of Undoing many 
changes at the same time. Save your Song, experiment, and if you don't like what 
you got, Revert to the last saved version.

Import Audio File

Imports an audio file (of format AIFF or Sound Designer II) into the Arrange win-
dow. See page 197:

Export Audio File

Makes a mixdown of all audio between the Left and Right Locators, including all 
unmuted Audio Tracks, fades, effects and other mixer settings. A new audio file is 
created, which can later be re-imported into the Arrangement. See page 199.

Import MIDI File

A MIDI file document in the Finder
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Opens a standard MIDI file. This is the main way to incorporate music made on 
other sequencers. When you select this item, you are asked if you want to incorpo-
rate the MIDI file into the current Arrangement (starting at the Left Locator) or put 
it in a new Arrange window of its own.

• Cubasis AV recognizes Standard MIDI files if they have the File Type 
“Midi” or the extension “.MID”.

• The program can read MIDI files in formats 0 or 1.

• The only non-MIDI Events that are imported are the time signatures and 
tempi on the Master Track and the Track names.

Export MIDI File

This option allows you to export the MIDI music (not the audio) in the current Ar-
rangement as a Standard MIDI file. Cubasis AV normally saves MIDI files in for-
mat 1, but if only one unmuted Track exists, a file of type 0 is created. Due to the 
way MIDI files are defined, all Parts on each Track will be joined together into one 
long “Part” in the saved file.

• Muted Tracks are not included. 

• The only non-MIDI Events that are saved are the time signatures and 
tempi on the Master Track and the Track names (names are saved as 
text).
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Movies submenu

This submenu contains all Movie-related items, as described in the Movies chapter. 
The three items on the submenu are:

Setup Movies...

This menu option lets you make up a list of QuickTime movies to use with your 
Song (described in the Movies chapter).

MovieTracks

This menu item opens up the MovieTracks window. This window allows you to ex-
port and import audio tracks to and from QuickTime movies, as described in the 
Movies chapter.

Movies

This menu item opens a sub-menu with a list of the movies that have been added to 
the song. If you select one of these movies, a window will be opened to show the 
selected movie. See the Movies chapter for more details.

Page Setup

Opens a standard Page Setup dialog. Use this for setting page size, margins, etc. 
when printing scores (see page 291).
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Print (only available in Score Edit)

Select this to print scores (see page 291).

Quit

Selecting this item (or pressing [Command]-[Q]) quits the program. A dialog box 
allows you to Save before quitting.

● If you quit Cubasis AV without saving, a dialog box will appear, asking you if 
you want to delete all audio files created since you last saved the Song. If you 
click Yes, these files will be permanently removed from the hard disk.
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The Edit Menu

Undo

You can Undo your last action by selecting this menu item or by pressing 
[Command]-[Z]. 

• Most of the time, the menu item also gives you a clue about what will be 
undone. 
If for example it says “Undo Delete”, the last thing you did was deleting 
something.

• If you wish to “Undo the Undo”, this is possible since after an Undo, this 
menu command changes to “Redo”.

• If the menu item is greyed out, nothing can be undone. 

The following operations can be undone:

Arrange window:

Everything can be undone (even a recording) except: 

• Import Audio File on the File menu.
• Erasing audio files permanently from the hard disk, using [Command]-

[Backspace].
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Pool

Everything can be undone, except the following operations:

• Export Segments.
• Import Audio File.
• Save Pool.
• Load Pool.
• Erasing audio files permanently from the hard disk, using [Command]-

[Backspace].

Master Track:

• All Event operations such as Insert, Delete, Cut, Paste and so on, can be un-
done, but not the actual editing of tempi and time signatures.

Cut

This takes the selected item(s), removes them from the window they were in and 
puts them in an invisible “storage bin” called the Clipboard. You can later Paste 
them into the same window or another of the same type (i.e. Parts can be Pasted 
into Arrange windows, MIDI Events can be Pasted into MIDI Editors).
- 354 - 



Copy

This takes the selected item(s) (Parts, notes or other MIDI Events, etc.) and copies 
them to an invisible “storage bin” called the Clipboard. You can later Paste them 
into the same window or another of the same type (i.e. Parts can be Pasted into 
Arrange windows, MIDI Events can be Pasted into MIDI Editors).

Paste

If you have used Cut or Copy to put something on the Clipboard, you can use this 
command to put that something back into the active window. You can Paste as 
many times as you want from the Clipboard.

Objects are always Pasted in at the current Song Position. Parts can be Pasted into 
Arrange windows only, MIDI Events can be Pasted into MIDI Editors only. 

Delete

This simply deletes the selected object(s), just like pressing [Backspace] on the 
computer keyboard. Depending on what is selected, the menu item may be called 
“Delete Part”, “Delete Entry”, etc. to help you avoid deleting the wrong objects.
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Select All

This command selects all objects in the window (Parts in the Arrange window etc.). 
Select All can be performed by pressing [Command]-[A] on the computer keyboard.

Edit

Selecting this (or pressing [Command]-[E]) opens the Key Edit window for the 
selected MIDI Part(s) or MIDI Track. See Key Edit.

List

Selecting this (or pressing [Command]-[G]) opens the List Edit window for the 
selected MIDI Part(s) or MIDI Track. In List Edit, you can only edit Parts on the 
same Track. See List Edit.

Score

Selecting this (or pressing [Command]-[R]) opens the Score Edit window for the 
selected MIDI Part(s) or MIDI Track. See Score Edit.

Mastertrack

Opens the Master Track editor. This can also be done by pressing [Command]-[M] 
on the computer keyboard.
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The Parts Menu

Create Part

This creates a new empty Part on the active Track, beginning at the Left Locator 
and ending at the Right Locator. This can also be done by double clicking in the 
Part Display or pressing [Command]-[P] on the computer keyboard.

Repeat...

This function repeats the selected Parts and lines up the copies after the original(s). 
Selecting the menu item (or pressing [Command]-[K] on the computer keyboard) 
brings up a dialog box in which you can specify the number of copies.
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Cut Notes

This command makes sure all notes in a Part end where the Part ends and no later. 
It is possible to get notes which “stick out” outside the Part, for example after using 
the Scissors or Pencil tools, and this isn't always desired. To change this situation, 
select the Parts and use Cut Notes.
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The Functions Menu

Over Quantize

This type of Quantizing moves the notes to the closest Quantize value, without 
changing their lengths. It also tries to detect chords, and keep them together when 
quantizing.

• Over Quantize can also be performed by pressing [Q] on the computer 
keyboard.

Undo Quantize

Quantizing is not permanent. You can at any time (even after Saving) select Undo 
Quantize (or press [U] on the computer keyboard) to restore any selection of Events 
to their original recorded timing.

Delete Doubles

This command erases all double notes. Such doubles most often occur when you 
record in Cycle mode and record over more than one lap. Double notes can sound 
like short delays, flanger effects, or even just as one loud note.

• Notes are considered to be “doubled” when they have the same note 
number (the same pitch) and have identical start points.
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Delete Cont. Data

This command erases all Continuous data, or more specifically, the following:

• Controllers.
• Pitch Bend.
• Aftertouch.
• Poly Pressure.
- 360 - 



The Options Menu

Follow Song

When this is activated, the Part Display in the Arrange window “moves” (or 
“scrolls”) with the Song when you play back, rewind, record and so on.

• You may turn Follow Song on and off by pressing [F] on the computer 
keyboard.

Reset On Stop

When this is activated, the following controllers are “reset” each time you stop 
Cubasis AV’s playback:

• Pitch Bend.
• Modulation.
• Aftertouch.

The standard MIDI messages “All Notes Off” and “Reset all Controllers” are also 
sent out.
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MIDI Thru

By activating/deactivating this option you decide if Cubasis AV is to echo incoming 
MIDI data. In most cases this should be activated (ticked).

Play in Background

When this item is ticked, Cubasis AV will keep playing, even if you switch over to 
another program. However, it will then also keep control of the serial port you are 
using (Modem/Printer) so you can’t use another MIDI program at the same time.

Double Click Opens

Opens a submenu, allowing you to select which editor should be opened when you 
double click on a MIDI Part: Key, List or Score Edit.
- 362 - 



Metronome...

The metronome dialog is used for three things:

• To set up how the program should behave when you activate recording 
(Precount, Prerecord and Preroll).

• To set up the Beep metronome (that uses the computer's sound).
• To set up the MIDI Metronome (that plays a click on one of your MIDI 

instruments).
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Precount

• By enabling/disabling the Precount you can decide if you want a count-in at 
all when you activate recording.

• By changing the Bars value you can set how long you want the Precount to 
be.

• If you disable the “From Mastertrack” function you can change the Time Signa-
ture for the count-in.

Prerecord

If this function is activated, Cubasis AV will record during the Precount (count-in). 
Even if you don’t hear your other Tracks during the Precount, you can for example 
add a note at the upbeat, just before playback starts.

● You cannot record before song position 1.1.0 (the beginning of the song).

Preroll

When this is activated, the Precount (count-in) is not silent, instead you will hear 
the last bar(s) before the Left Locator. How many bars you hear depends on the 
Bars setting described above.
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If you use the Preroll feature, you might want Prerecord activated at the same time, 
so that you can record during the Preroll.

The remaining options in the Metronome dialog are for setting up how the metro-
nome should sound.

Beep

This allows you to turn the beep from the computer's speaker on and off.

When you activate 
recording from the Left 
Locator, with Preroll 
activated...

... the Song Position 
jumps back a number of 
bars and recording is 
activated.
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MIDI Click

When this is activated, you will get a Metronome via MIDI (if Click is activated on 
the Transport Bar). Use the settings below to route the metronome to for example a 
bass drum or a sidestick sample from a drum machine or similar.

Use this: To set:

High Note The MIDI note number for the downbeats.

High Velocity The velocity value for the downbeats.

Low Note The MIDI note number for all other Metronome “clicks”.

Low Velocity The velocity value for all other Metronome “clicks”.

Channel: The MIDI Channel for all Metronome “clicks”.
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MIDI Interface

This allows you to select to which computer port your MIDI interface is connected. 

● Cubasis AV expects the interface to operate at a clock rate of 1 MHz. If your 
interface doesn’t have a clock rate switch, you do not need to worry about 
this. If it does, set it to 1 MHz.
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The Windows Menu

Hide/Show Transport

This allows you to switch between hiding and showing the entire Transport Bar. 

• You can use the computer keyboard to activate the functions on the 
Transport Bar, even though it is hidden. See page 374.

The Arrangement list

The lower part of the Windows menu contains a list of all Arrangements in the 
Song.

• Selecting one of the Arrangements on the list, brings the corresponding 
Arrange window to the front.
This is crucial if you have used the Set Aside command to hide Arrangements 
(see page 138).

Tools
Opens the Toolbox for the active window.
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What This Chapter Contains
The following is a list of the keyboard short-cuts for many of Cubasis AV's functions.

Numeric Keypad

Key Command Function:

[*] Activate recording

[Enter] Start/Continue

[0] or [spacebar] 1st time – Stop
2nd time – Go to Left Locator/ 1. 1. 0
3rd time – Go to 1. 1. 0

[delete/numlock] Rewind (top left key)

[=] Fast Forward

[+] Increase Tempo

[–] Decrease Tempo

[1] Go to Left Locator

[2] Go to Right Locator

[9] Go to last Stop Position
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[Shift] + [1] Store Song Position as Left Locator

[Shift] + [2] Store Song Position as Right Locator

[3] to [8] Go to Cue Point 3 to 8

[Shift] + [3] to [8] Store Song Position as Cue Point 3 to 8

[/] Cycle On/Off

Key Command Function:
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Typewriter Keyboard
The various key commands are grouped after their contexts, to make it easier to 
find what you’re looking for:

File Handling and General Procedures

Key Command Function

[Command]-[O] Open 

[Command]-[S] Save

[Command]-[Z] Undo

[Command]-[X] Cut

[Command]-[C] Copy

[Command]-[V] Paste

[Command]-[Q] Quit
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Window Handling

[Command]-[N] New Arrange window

[Command]-[W] Close active window

[Return] Close box or "click button with heavy border" in Dialog Boxes

[Esc] Close and Cancel in Dialog Boxes

[Command]-[E] Open Key Edit window

[Command]-[G] Open List Edit window

[Command]-[R] Open Score Edit window

[G] Decrease horizontal magnification

[H] Increase horizontal magnification

[Shift]-[G] Decrease vertical magnification

|Shift]-[H] Increase vertical magnification
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Transport Bar functions

Key Command Function

[P] Set Position

[L] Set Left Locator

[R] Set Right Locator

[C] Click On/Off

[M] Master Track On/Off

[S] Solo On/Off

[F] Follow Song On/Off
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Arrange Window Selection and Editing

Key Command Function

[Command]-[A] Select All

[→] Select Next Part

[←] Select Previous Part

[↑ ] Go one Track up

[↓ ] Go one Track down

[Backspace] Delete Selection

[Command]-
[Backspace]

Permanently delete the audio file(s) in the selected Parts 
from the hard disk.

[Q] Over-Quantize

[U] Undo Quantize

[1]-[7] Set Quantize value

[T] Set Quantize value to triplets

[.] Set Quantize value to dotted
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Pool functions

[Option]-[I] Open/Close Inspector

[Command]-[M] Display Master Track

[Command]-[P] Create Part

[Command]-[K] Repeat

Key Command Function

[Option]-[D] Duplicate Segment

[Command]-[Backspace] Permanently delete the selected audio file from the hard 
disk.

Key Command Function
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All MIDI Editor windows

Key Command Function

[Return] Keep (Close editor, keeping changes)

[Esc] Cancel (Close editor, discarding changes)

[Insert] Insert Event

[Tab] Move one Snap in Step Edit

[Option]-[O] Loop On/Off

[Option]-[L] Input Left Loop boundary

[Option]-[R] Input Right Loop boundary

[Option]-[I] Info On/Off

[A] Edit Solo On/Off
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Key Edit only

List Edit only

Key Command Function

[Caps Lock] Restrict Pen to length changes only

[→] Next Note

[←] Previous Note

Key Command Function

[↑ ] Previous Event

[↓ ] Next Event
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Score Edit only

• In all MIDI Editors, the arrow keys can be used in combination with the 
[Shift] key to select several notes.

Key Command Function

[→] Next Note

[←] Previous Note

[↓ ] Next Staff

[↑ ] Previous Staff

[Command]-[P] Print Score
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